Implementacion de un VI

Esta leccidn le ensefia cémo implementar cédigo en LabVIEW. Se explicara
cémo diseiiar una interfaz de usuario, elegir un tipo de datos, documentar
su c6digo, usar estructuras de bucles como los bucles While y For, afiadir
temporizacién por software a su cédigo, mostrar sus datos como una curva
y tomar decisiones en su cédigo utilizando una estructura Case.
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A. Diseiio del panel frontal

En la fase de disefio del método de desarrollo de software se identifican las
entradas y salidas del problema. Esta identificacion conduce directamente
al disefio de la ventana del panel frontal.

Puede recuperar las entradas del problema con los siguientes métodos:

* adquiriendo desde un dispositivo de adquisicion de datos o un
multimetro

e leyendo directamente desde un fichero

* manipulando controles

Puede ver las salidas del problema con indicadores, como gréficos o LEDs
o registrar las salidas en un fichero. También puede extraer datos de un
dispositivo con la generacion de sefiales. Las lecciones de adquisicién de
datos, generacion de sefiales y registro en ficheros se trataran después en
este curso.

Disefio de controles e indicadores

Al elegir controles e indicadores, deben ser apropiados para la tarea que
desee realizar. Por ejemplo, cuando quiera determinar la frecuencia de una
onda sinusoidal, elija un control de disco; cuando desee ver la temperatura,
elija un indicador de termémetro.

Etiquetas y titulos

Etiquete con claridad los controles e indicadores. Estas etiquetas ayudan a
los usuarios a identificar el objetivo de cada control e indicador. Asimismo,
el etiquetado claro ayuda a documentar su c6digo en el diagrama de bloques.
Las etiquetas de controles e indicadores se corresponden con los nombres

de los terminales del diagrama de bloques.

Los titulos ayudan a describir el control de un panel frontal. Los titulos no
aparecen en el diagrama de bloques. El uso de titulos permite documentar
la interfaz del usuario sin abarrotar el diagrama de bloques con texto
adicional. Por ejemplo, en la estacién meteorolégica debe incluir un limite
superior para el nivel de temperatura. Si la temperatura supera este nivel,
la estacién meteorolégica indicard una advertencia de golpe de calor. Podria
Hamar a este control Upper Temperature Limit (Celsius). Sin
embargo, esta etiqueta ocuparia espacio innecesario en el diagrama de
bloques. Use un titulo para el control Upper Temperature Limit
(Celsius) y laetiqueta para crear una descripcién mas breve para

el diagrama de bloques, como Upper Temp.




Opciones de controles e indicadores

Puede configurar valores predeterminados para los controles. La figura 4-1
muestra un valor predeterminado de 35 °C. Configurando un valor
predeterminado puede adoptar un valor razonable para un VI si el usuario
no configura otro valor durante el tiempo de ejecucion. Para configurar

el valor predeterminado, siga estos pasos:

1. Escriba el valor deseado.

2. Haga clic con el botén derecho en el control y seleccione Data
Operations»Make Current Value Default en el ment contextual.
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Figura 4-1. Configuracion de valores predeterminados

También puede ocultar y ver elementos en controles e indicadores. Por

ejemplo, en la figura 4-2 puede ver el titulo y la etiqueta. No obstante, s6lo
necesita ver el titulo. Para ocultar la etiqueta, haga clic con el botén derecho
en el control y seleccione Visible Items»Label, como se ve en la figura 4-2.
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Uso del color

El uso adecuado del color puede mejorar el aspecto y la funcionalidad de su
interfaz de usuario. Sin embargo, si usa demasiados colores pueden chocar
colores que den un aspecto demasiado ocupado y distraido a la interfaz de
usuario.

LabVIEW incluye un selector de color que puede ayudar a elegir los colores
adecuados. Seleccione la herramienta de color y haga clic con el botén
derecho en un objeto o espacio de trabajo para ver el selector de color.

La parte superior del selector de color contiene un espectro en escala

de grises y un cuadro que puede usar para crear objetos transparentes.

El segundo espectro contiene colores apagados, ideales para fondos y
objetos del panel frontal. El tercer espectro contiene colores ideales para
resaltar. Si mueve el cursor verticalmente desde los colores de fondo a

los colores de resaltar, le ayudard a seleccionar los colores apropiados para
resaltar un color de fondo especifico.

Los siguientes consejos son ttiles para combinar colores:

* Use los colores predeterminados de LabVIEW. LabVIEW sustituye
colores de forma similar a como sustituye fuentes. Si uno de los colores
del VI no se encuentra, LabVIEW lo sustituye por el mds similar.
También puede utilizar los colores del sistema para adaptar el aspecto
de una ventana del panel frontal a los colores del sistema de cualquier
ordenador que ejecute el VI.

* Empiece con los grises. Seleccione uno o dos tonos de gris y elija
colores para resaltar que contrasten bien con el fondo.

° Aifiada colores de resaltado con moderacién (en curvas, botones de
abortar y quiza las miniaturas del deslizador) para configuraciones
importantes. Los objetos pequefios necesitan colores mads fuertes y
mads contraste que los objetos mas grandes.

e Use diferencias de contraste mds que diferencias de color. A los usuarios
daltonicos les cuesta discernir objetos cuando se distinguen por el color
mds que por el contraste.

e Use el espaciado para agrupar objetos en lugar de por colores que
combinen.

* Puede aprender mucho sobre el color en paneles de instrumentos
de hardware independiente, mapas y revistas.

» Elija objetos en la categoria System de la Paleta de Controles si desea
que los controles de su panel frontal usen colores del sistema.



Espaciado y alineacion

El espacio en blanco y la alineacién probablemente sean las técnicas mds
importantes para agrupar y separar. Cuantos mas elementos pueda encontrar
el 0jo en una linea, més limpia y mds cohesiva parecerd la organizacion.
Cuando los elementos estdn en una linea, el ojo sigue ésta de izquierda a
derecha o de arriba a abajo. Esto se relaciona con la direccién de la escritura.
Aunque algunas culturas ven los elementos de derecha a izquierda, casi
todas lo hacen de arriba a abajo.

Cuando disefie el panel frontal, piense en cémo los usuarios interaccionan
l6gicamente con el VI 'y agrupan controles e indicadores. Si varios controles
estan relacionados, afiada un borde decorativo a su alrededor o col6quelos
en un cluster.

No coloque objetos demasiado juntos. Deje algin espacio en blanco entre
los objetos para facilitar la lectura del panel frontal. El espacio en blanco
también evita que los usuarios hagan clic en el control o botén equivocado.

Observe como las lineas divisorias entre las secciones de menu de
la figura 4-3 ayudan a buscar los elementos rdpidamente y a fortalecer
la relacidn entre los elementos de las secciones.
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Texto y fuentes

No coloque objetos encima de otros. Incluso el cubrir parcialmente un
control o indicador con una etiqueta u otro objeto ralentizard las
actualizaciones de la pantalla y puede hacer parpadear el control o
indicador.

El texto es mds facil de leer y la informacién se entiende mejor cuando se
encuentra ordenado correctamente. Use las fuentes predeterminadas de
LabVIEW. Por ejemplo, LabVIEW define sus fuentes internas como las
fuentes predeterminadas del sistema. Cuando mueve VIs entre plataformas,
LabVIEW actualiza automdticamente sus fuentes internas para que
coincidan con la fuente predeterminada del sistema de la plataforma actual.
Ademds, si intenta abrir un VI que usa una fuente no disponible, LabVIEW
la sustituird por la mds parecida. Por ejemplo, si intenta ver un VI que usa
la fuente Arial en un ordenador que no la tiene, LabVIEW la sustituird por
una similar de las instaladas.

Si usa demasiados estilos de fuente, su ventana del panel frontal puede
parecer saturada y desorganizada. Use en su lugar dos o tres tamaiios
distintos de la misma fuente. Las fuentes tipo Serif ayudan a reconocer
palabras enteras desde lejos. Si utiliza mas de un tamafio de una misma
fuente, los tamafios deben diferenciarse bien. De lo contrario, parecerd un
error. [gualmente, si usa dos fuentes distintas, diferéncielas bien.

Disefe su interfaz de usuario con fuentes mds grandes y mds contraste para
estaciones industriales. El resplandor del alumbrado o la necesidad de leer
informacion desde la distancia pueden dificultar la lectura de las fuentes
normales. Asimismo, recuerde que las pantallas tactiles suelen requerir
fuentes mas grandes y mads espaciado entre los elementos de seleccion.

@ Nota Si las fuentes no existen en una mdquina, las que se sustituyan pueden hacer que
la interfaz aparezca torcida.

Consejos y herramientas de la interfaz de usuario

Algunas de las herramientas integradas de LabVIEW para crear ventanas
de paneles frontales ficiles de usar son: controles del sistema, controles de
fichas, decoraciones, menus y cambio de tamafio automadtico de objetos del
panel frontal.

Controles del sistema

Una técnica comin de la interfaz de usuario es mostrar cuadros de didlogo
en el momento apropiado para interactuar con el usuario. Puede hacer que
un VI actie como un cuadro de didlogo seleccionando File» VI Properties,
seleccionando la categoria Window Appearance y después la opcién
Dialog.




Use los controles e indicadores del sistema situados en la paleta System
en los cuadros de didlogo que cree.Los controles del sistema cambian de
aspecto en funcién de qué plataforma ejecute el V1. Si ejecuta el VI en una
plataforma distinta, los controles del sistema adaptan su color y aspecto para
coincidir con los controles del cuadro de didlogo estdndar de esa plataforma.

L.os controles del sistema suelen descartar todos los colores salvo el
transparente. Si estd integrando un gréfico o un control que no es del sistema
en las ventanas del panel frontal, combinelos ocultando algunos bordes o
seleccionando colores parecidos a los del sistema.

Controles de fichas

Los instrumentos fisicos suelen tener buenas interfaces de usuario. Imite en
gran medida sus principios de disefio, pero use controles mas pequefios o
eficientes, como controles de anillo o de ficha, cuando sea apropiado. Use
controles de ficha para superponer controles e indicadores del panel frontal
en una zona mds pequefia.

Para afiadir pdginas adicionales a un control de ficha, haga clic con el boton
derecho en una ficha y seleccione Add Page Before o Add Page After
desde el menu contextual. Vuelva a etiquetar las fichas con la herramienta
de etiquetado y coloque objetos del panel frontal en las paginas
correspondientes. Los terminales de estos objetos estdn disponibles en el
diagrama de bloques, al igual que los terminales de otros objetos del panel
frontal (excepto las Decoraciones).

Puede cablear el terminal de control enumerado del control de la ficha con
el selector de una estructura Case para producir diagramas de bloques mas
limpios. Con este método se asocia cada pagina del control de ficha con
un subdiagrama de la estructura Case. Puede colocar los terminales de
controles e indicadores de cada pagina del control de ficha (y los nodos y
cables del diagrama de bloques asociados con esos terminales) en los
subdiagramas correspondientes de la estructura Case.

Decoraciones

Use las decoraciones situadas en la paleta Decorations para agrupar o
separar objetos del panel frontal con cuadros, lineas o flechas. Los objetos
de la paleta Decorations no muestran datos.

Menis

Use ments personalizados para presentar la funcionalidad del panel frontal
ordenadamente y con relativamente poco espacio. Si usa poco espacio,
dejard hueco en el panel frontal para controles e indicadores importantes,
elementos para principiantes, elementos necesarios para productividad y
elementos que no encajen bien en los ments. También puede crear métodos
abreviados de teclado para elementos de menu.



Para crear un mend contextual en tiempo de ejecucién para objetos del panel
frontal, haga clic con el botén derecho en el objeto del panel frontal y
seleccione Advanced»Run-Time Shortcut Menu»Edit. Para crear un
menu personalizado en tiempo de ejecucidn para su VI, seleccione Edit»
Run-Time Menu.

Cambio de tamaiio automatico para objetos del panel frontal

Use las opciones File»VI Properties»Window Size para configurar el
tamafio minimo de una ventana, mantener la proporcién de ésta durante los
cambios de la pantalla y configurar objetos del panel frontal para cambiar su
tamafio de dos modos diferentes. Cuando disefie un VI, piense en si el panel
frontal puede verse en ordenadores con distintas resoluciones de pantalla.
Seleccione File» VI Properties, después Window Size en el mend
desplegable Category y active la casilla de verificacién Maintain
proportions of window for different monitor resolutions para mantener
las proporciones de la ventana del panel frontal relativas a la resolucién de
la pantalla.

B. Tipos de datos de LabVIEW

Terminales

Existen muchos tipos de datos. Ya aprendid tipos de datos numéricos,
booleanos y de cadena de caracteres en la leccion 2, Explorando LabVIEW.
Otros tipos de datos son los enumerados, los dindmicos y otros. Incluso
dentro de los tipos de datos numéricos se distingue entre nimeros enteros y
fraccionales.

Los terminales del diagrama de bloques comunican visualmente al usuario
informacion sobre el tipo de datos que representan. Por ejemplo, en la
figura 4-4, Altura (cm) es un dato numérico en coma flotante y doble
precision. Esto se indica por el color del terminal, naranja, y por el texto
del terminal, DBL.

[Determines the area of a triangle. |

Figura 4-4. Ejemplo de tipo de datos del terminal



Tipos de datos numéricos
El tipo de dato numérico representa niimeros de varias clases. Para cambiar
el tipo de representacion de un niimero, haga clic con el botén derecho en el

control, indicador o constante y seleccione Representation, como se ve en
la figura 4-5.
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Figura 4-5. Representacion numérica

Cuando cablea dos o mds entradas numéricas de distintas representaciones
a una funcién, ésta normalmente devuelve los datos en la representacion
mds grande o amplia. Las funciones convierten las representaciones mas
pequefias a la representaciéon mas amplia antes de la ejecuciéon y LabVIEW
coloca un punto de conversién en el terminal donde se realiza la conversion.

El tipo de dato numérico incluye estas subcategorias de representacion:
nimeros en coma flotante, niimeros enteros con signo, niimeros enteros sin
signo y nimeros complejos.
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Nimeros en coma flotante

Los nimeros en coma flotante representan ntiimeros fraccionales.
En LabVIEW, los nimeros en coma flotante se representan con
el color naranja.

Precision simple (SGL): los nimeros en coma flotante de precision simple
tienen un formato de precisién simple de 32 bits IEEE. Use los ntimeros
en coma flotante de precision simple para ahorrar memoria y evitar

el desbordamiento del rango de los ndmeros.

Doble precision (DBL): los niimeros en coma flotante de doble precision
tienen un formato de precision doble de 64 bits IEEE. La doble precision es
el formato predeterminado para objetos numéricos. Use los niimeros en
coma flotante de doble precisién para la mayoria de las situaciones.

Precision ampliada (EXT): en la memoria, el tamafio y la precisién
de niimeros de precisién ampliada varian en funcién de la plataforma.
En Windows tienen un formato de precisién ampliada de 80 bits IEEE.

Tipo de datos de punto fijo

El tipo de datos de punto fijo es numérico y representa un conjunto de
nimeros racionales que utilizan digitos binarios o bits. A diferencia del tipo
de datos en coma flotante, que permite que varie el niimero total de bits que (
usa LabVIEW para representar niimeros, puede configurar los niimeros

de punto fijo para que usen siempre un nimero concreto de bits. Asi, el
hardware y los destinos que sélo pueden almacenar y procesar datos con un
numero limitado o fijo de bits podran almacenar y procesar los nimeros.
Puede especificar el rango y la precisién de ndmeros de punto fijo. i

Nota Para representar un niimero racional con el tipo de datos de punto fijo,
el denominador del nimero racional debe ser una potencia de 2, porque el sistema
de niimeros binarios es de base 2.

Use el tipo de datos de punto fijo cuando no necesite la funcionalidad
dindmica de la representacién de coma flotante o cuando desee trabajar con

un destino que no admita la aritmética de coma flotante, como un destino
FPGA.

Especifique la codificacion, la longitud de palabra y la longitud de palabra
entera de un niimero de punto fijo cuando desee que el nimero se adapte a
cierto tamaiio de bits. |

Codificacién: la codificacion binaria del nimero de punto fijo. Puede
seleccionar con signo o sin signo. Si selecciona con signo, el bit del signo es
siempre el primero en la cadena de caracteres de bits que representa los
datos.



Longitud de palabra: el nimero total de bits de la cadena de caracteres de
bits que usa LabVIEW para representar todos los valores posibles de los
datos de punto fijo. LabVIEW acepta una longitud médxima de palabra de
64 bits. Ciertos destinos pueden limitar los datos a longitudes menores de
palabra. Siabre un VIen un destino y el VI contiene datos de punto fijo con
longitudes de palabra mayores que las que puede aceptar el destino, el VI
contendrd cables rotos. Consulte la documentacién de un destino para
determinar la méxima longitud de palabra que acepta.

Longitud de palabra entera: el nimero de bits enteros en una cadena de
caracteres de bits que usa LabVIEW para representar todos los posibles
valores del dato de punto fijo o, dada una posicioén inicial a la izquierda o a
la derecha del bit més significativo, el nimero de bits a desplazar la coma
binaria y llegar al bit més significativo. La longitud de palabra del nimero
entero puede ser mayor que la longitud de palabra, y puede ser positivo o
negativo.

Nimeros enteros

Los niimeros enteros representan los niimeros naturales. Los nuimeros
enteros con signo pueden ser positivos o negativos. Use los tipos de datos de
nimeros enteros sin signo cuando sepa que el nimero entero es siempre
positivo. En LabVIEW, los niimeros enteros se representan con el color azul.

Cuando LabVIEW convierte los numeros en coma flotante en nimeros

enteros, el VI redondea al niimero entero par més cercano. Por ejemplo,
LabVIEW redondea2,5a2y 3,5a4.

Byte (I8): los nimeros enteros Byte tienen 8 bits de almacenamiento.
Word (I16): los niimeros enteros Word tienen 16 bits de almacenamiento.

Long (I32): los nimeros enteros Long tienen 32 bits de almacenamiento.
En la mayoria de los casos es mejor utilizar un nimero entero de 32 bits.

Quad (I64): los numeros enteros Quad tienen 64 bits de almacenamiento.

Nimeros complejos

Los nimeros complejos se representan con dos valores unidos en la
memoria: uno representa la parte real y otro la parte imaginaria. En
LabVIEW, como los niimeros complejos son un tipo de nimero en coma
flotante, los niimeros complejos también se representan con el color naranja.

Complejo simple (CSG): los nimeros complejos de coma flotante de
precision simple constan de valores reales e imaginarios y tienen un formato
de precision simple de 32 bits IEEE.



Complejo doble (CDB): los niimeros complejos de coma flotante de doble
precision constan de valores reales e imaginarios y tienen un formato de
doble precisién de 64 bits IEEE.

Complejo ampliado (CXT): los niimeros complejos de coma flotante de
precisién ampliada constan de valores reales e imaginarios y tienen un
formato de precisién ampliada IEEE. En la memoria, el tamafio y

la precision de nimeros de precision ampliada varian en funcion de

la plataforma. En Windows tienen un formato de precisién ampliada

de 80 bits IEEE.

Valores booleanos

LabVIEW almacena datos booleanos como valores de 8 bits. Si el valor de
8 bits es cero, el valor booleano es FALSE. Cualquier valor que no sea cero
representard TRUE. En LabVIEW, el color verde representa datos
booleanos.

Los valores booleanos también tienen una accién mecdnica asociada a ellos.
Las dos acciones principales son bloquear y conmutar. Puede seleccionar
uno de los siguientes comportamientos de control:

e Switch when pressed: cambia el valor del control cada vez que hace
clic en €l con la herramienta de operaciones. La frecuencia con la que
el VI lee el control no afecta a este comportamiento. *’

e Switch when released: cambia el valor del control sélo después de
soltar el botén del ratén mientras hace clic dentro del limite gréfico del ;
control. La frecuencia con la que el VI lee el control no afecta a este
comportamiento.

e Switch until released: cambia el valor del control cuando hace clic en
€l y conserva el nuevo valor hasta que suelte el bot6n del ratén. En este
momento, el control vuelve a su valor predeterminado, al igual que el
funcionamiento del timbre de una puerta. La frecuencia con la que el VI
lee el control no afecta a este comportamiento. No puede seleccionar
este comportamiento para un control de botones de radio.

* Latch when pressed: cambia el valor del control cuando hace clic en
€l 'y conserva el nuevo valor hasta que el VI lo lea una vez. En este
momento, el control vuelve a su valor predeterminado, aunque siga
pulsando el botén del ratén. Este comportamiento es similar al de un (
disyuntor y es til para detener un bucle While o para que el VI realice
una accion s6lo una vez cada vez que ajuste el control. No puede
seleccionar este comportamiento para un control de botones de radio.




Latch when released: cambia el valor del control sélo después de soltar
el botdn del ratén dentro del limite gréifico del control. Cuando el VI
lo lee una vez, el control vuelve a su valor predeterminado. Este
comportamiento funciona del mismo modo que los botones de los
cuadros de didlogo y del sistema. No puede seleccionar este
comportamiento para un control de botones de radio.

Latch until released: cambia el valor del control cuando hace clic en €l
y conserva el valor hasta que el VI lo lea una vez o suelte el botén del
ratén, en funcién de lo que ocurra en tltimo lugar. No puede seleccionar
este comportamiento para un control de botones de radio.

Para saber mds de la accién mecdnica, experimente con el VI Mechanical
Action of Booleans en el NI Example Finder.
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Figura 4-6. Accion mecanica booleana

Cadenas de caracteres

Una cadena de caracteres es una secuencia de caracteres ASCII
visualizables y no visualizables. Las cadenas de caracteres tienen un
formato independiente de las plataformas para la informacién y los datos.
Algunas de las aplicaciones mds comunes de las cadenas de caracteres son:

Generacion de mensajes de texto simples

Control de instrumentos enviando comandos de texto al instrumento y
devolviendo valores de datos en forma de cadenas de caracteres ASCII
o binarias que después convierte en valores numéricos.



* Almacenamiento de datos numéricos en disco. Para almacenar datos
numeéricos en un fichero ASCII, primero debe convertir los datos
numéricos en cadenas de caracteres antes de escribir los datos en un
fichero del disco.

* Peticién o visualizacién de datos con cuadros de didlogo

En el panel frontal, las cadenas aparecen como tablas, cuadros de entrada de
texto y etiquetas. LabVIEW incluye VIs y funciones integradas que puede
utilizar para manipular cadenas de caracteres, como dar formato a cadenas
de caracteres, analizar cadenas de caracteres y otras modificaciones.

Consulte el tema ASCII Codes de la Ayuda de LabVIEW para obtener
informacién acerca de cédigos ASCII y funciones de conversion.

En LabVIEW, las cadenas de caracteres se representan con el color rosa.

Haga clic con el botdn derecho en el control o indicador de una cadena de
caracteres del panel frontal para seleccionar entre los tipos de visualizacién
que aparecen en la siguiente tabla. La tabla también muestra un ejemplo
de mensaje para cada tipo de visualizacién.

Tipo de
visualizacién Descripcién Mensaje /
Visualizacién Muestra caracteres imprimibles | Existen cuatro tipos de
normal

utilizando la fuente del control. visualizacidn.\ es una barra )_
Los caracteres no visualizables invertida.
normalmente aparecen como

cuadros. \
Visualizacién de | Muestra c6digos de barra Existen\scuatro\stipos\ /
codigos V invertida para todos los sde\svisualizaciédn.\n\\\ses\ \
caracteres no visualizables. suna\sbarra\sinvertida.
Visualizacién de | Muestra un asterisco (*) para IRk kkhkkhkkhkhkhkkkhhhhkhhkhkk i
contrasefia cada caracter, incluidos los KKK K K Kk K K Kk ok kK Rk
espacios.
Visualizacion Muestra el valor ASCII de cada | 5468 6572 6520 6172 6520
hexadecimal cardcter en hexadecimal en lugar | 666F 7572 2064 6973 706C (

del caracter. 6179 2074 7970 6573 2E0A
5C20 6973 2061 2062 6163
6B73 6C61l 7368 2E

LabVIEW almacena cadenas de caracteres como un puntero a una
estructura que contiene un valor con una longitud de 4 bytes seguido
de un array 1D de nidmeros enteros de bytes (caracteres de 8 bits).




Enums

Un enum (indicador, constante o control enumerado) es una combinacién
de tipos de datos. Un enum representa una pareja de valores, una cadena
de caracteres y un numérico, donde el enum puede ser uno de una lista de
valores. Por ejemplo, si cred un tipo de enum llamado Mes, las parejas de
valores posibles para una variable Mes son Enero-0, Febrero-1, etc. hasta
Diciembre-11. La figura 4-7 muestra un ejemplo de estas parejas de datos
en el cuadro de didlogo Properties para un control enumerado.

13 Enum Prépétﬁes: lonth

. Documentation _ Data

- Appearance  Data Type | Display Format Edit Items

Items
Januaty
February
farch
April

May

{0 June

L] July
August N i

| el |

‘ OK H Cancel H Help }

Figura 4-7. Propiedades para el control enumerado Mes



Los enums resultan ttiles porque es mds facil manipular niimeros en

el diagrama de bloques que cadenas de caracteres. La figura 4-8 muestra
el control enumerado Mes (Month), la seleccién de una pareja de datos
en el control enumerado y el terminal correspondiente del diagrama

de bloques.

- Manth i Month Month
L1 January -

® ® ®

February
March
April

Mavy
June
Julye
August
September
Ortober
Movernber
Decermber

1 Control del panel frontal 3 Terminal del diagrama de blogues
2 Seleccidn de un elemento

Dinamicos

Figura 4-8. Control enumerado Mes (Month)

El tipo de datos dindmico almacena la informacién que genera o adquiere
un VI Express. El tipo de datos dindmico aparece como un terminal azul
oscuro, mostrado a la izquierda. La mayoria de VIs Express aceptan o
devuelven el tipo de datos dindmico. Puede cablear el tipo de datos dindmico
a cualquier indicador o entrada que acepte datos numéricos, de forma de
onda o booleanos. Cablee el tipo de datos dindmico a un indicador que
pueda presentar mejor los datos. Ejemplos de indicadores son graficos tipo
“graph”, gréficos tipo “chart” o indicadores numéricos.

La mayoria del resto de VIs y funciones de LabVIEW no aceptan el tipo
de datos dindmico. Para utilizar un VI o funcién integrada para analizar o
procesar los datos que incluye el tipo de datos dindmico, debe convertir
el tipo de datos dindmico.

Use el VI Express Convert from Dynamic Data para convertir el tipo de
datos dindmico en tipos de datos numéricos, de forma de onda y de array
para usar con otros VIs y funciones. Cuando coloca el VI Express Convert
from Dynamic Data en el diagrama de bloques, aparece el cuadro de didlogo




Configure Convert from Dynamic Data. El cuadro de didlogo Configure
Convert from Dynamic Data muestra opciones para especificar como
desea dar formato a los datos que devuelve el VI Express Convert from
Dynamic Data.

Cuando cablea un tipo de datos dindmico a un indicador de array, LabVIEW
afiade automaticamente el VI Express Convert from Dynamic Data al
diagrama de bloques. Haga doble clic en el VI Express Convert from
Dynamic Data para abrir el cuadro de didlogo Configure Convert from
Dynamic Data y controlar cémo aparecerdn los datos en el array.

C. Documentacion de cddigo

Los desarrolladores profesionales que mantienen y modifican VIs conocen
el valor de una buena documentacién. Documente bien el diagrama de
bloques para facilitar las futuras modificaciones del cédigo. Ademas,
documente bien la ventana del panel frontal para explicar el objetivo del VI
y los objetos del panel frontal.

Use ayudas, descripciones, propiedades de VI 'y un buen disefio para
documentar las ventanas del panel frontal.

Ayudas y descripciones

Las ayudas son breves descripciones que aparecen cuando mueve el cursor
sobre un control o indicador mientras se ejecuta un VI. Por ejemplo, podria
afiadir una ayuda para indicar que una temperatura es en grados Celsius o
explicar como funciona una entrada en un algoritmo. Las descripciones
ofrecen informacién adicional sobre controles e indicadores especificos.
Las descripciones aparecen en la ventana Context Help cuando mueve el
cursor sobre el objeto. Para afladir ayudas y descripciones a controles, haga
clic con el botdn derecho en el control o indicador y seleccione Description
and Tip desde el menti contextual.

Propiedades de VI

Use el componente Documentation del cuadro de didlogo VI Properties
para crear descripciones de VIs y enlazar desde VIs a ficheros HTML o a
ficheros de ayuda compilados. Para ver VI Properties, haga clic con el botén
derecho en el icono del VI en el panel frontal o en el diagrama de bloques y
seleccione VI Properties desde el menu contextual o seleccione File»VI
Properties. Después seleccione Documentation en el ment desplegable
Categories. No puede acceder a este cuadro de didlogo mientras se ejecuta
un VL.



Esta pagina incluye los siguientes componentes:

¢ VI description: contiene el texto que aparece en la ventana Context
Help cuando mueve el cursor sobre el icono de VI. Use las etiquetas
<B>y </B> alrededor de cualquier texto de la descripcién al que desee
dar formato en negrita. También puede utilizar la propiedad VI
Description para modificar la descripcion del VI programaticamente.

* Help tag: contiene el nombre del fichero HTML o la palabra clave del
indice del tema que desea vincular en un fichero de ayuda compilado.
También puede utilizar la propiedad Help:Document Tag para
configurar la etiqueta de ayuda programadticamente.

* Help path: contiene la ruta al fichero HTML o al fichero de ayuda
compilado que desea vincular desde la ventana Context Help. Si este i
campo esta vacio, el enlace Detailed help no aparecerd en la ventana
Context Help y se atenuard el botén Detailed help.

e Browse: muestra un cuadro de didlogo de fichero que se utiliza para
navegar hasta un fichero HTML o hasta un fichero de ayuda compilado
para utilizarlo como ruta de ayuda. \

Nombre de controles e indicadores

Si da nombres légicos y descriptivos a controles e indicadores, facilitard

el uso de los paneles frontales. Por ejemplo, si llama a un control
Temperature, un usuario quizd no sepa qué unidades utilizar. Sin

embargo, si lo llama Temperature °c, afiadird més informacién al panel
frontal. Ahora sabrd que debe introducir temperaturas en unidades métricas. {

Programacidn grafica

Aunque la naturaleza grifica de LabVIEW ayuda a la autodocumentacién
de diagramas de bloques, los comentarios adicionales ayudan a la hora

de modificar sus VIs posteriormente. Existen dos tipos de comentarios de
diagrama de bloques: los que describen la funcién u operacién de algoritmos
y comentarios que explican la finalidad de datos que pasan por cables.
Ambos tipos de comentarios aparecen en el siguiente diagrama de bloques.
Puede insertar etiquetas estdndares con la herramienta de etiquetado, o
insertando una etiqueta libre desde la subpaleta Functions»Programming»
Structures»Decorations. De forma predeterminada las etiquetas libres
tienen un color de fondo amarillo.
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Figura 4-9. Documentar un diagrama de bloques

Use las siguientes pautas para comentar los VIs:

Use comentarios en el diagrama de bloques para explicar lo que estd
realizando el cédigo.

Aunque el cédigo de LabVIEW puede autodocumentarse porque es
grifico, use etiquetas libres para describir como funciona el diagrama
de bloques.

No muestre etiquetas en llamadas de funcién y de subVls, ya que suelen
ser grandes y poco manejables. Un desarrollador que observe el
diagrama de bloques puede encontrar el nombre de una funcién o subVI
en la ventana Context Help.

Use etiquetas libres pequefias con fondos blancos para etiquetar cables
largos e identificar su uso. Etiquetar cables resulta util para los que
proceden de registros de desplazamiento y para cables largos que
pueden abarcar todo el diagrama de bloques. Consulte la seccion
Estructuras Case de esta leccion para obtener informacién adicional
acerca de los registros de desplazamiento.

Etiquete estructuras para especificar su funcionalidad principal.
Etiquete constantes para especificar su naturaleza.

Use etiquetas libres para documentar algoritmos que usa en los
diagramas de bloques. Si usa un algoritmo de un libro u otra referencia,
incluya la informacién de referencia.



Ejercicio 4-1

Objetivo

Caso

Disefio

Vi Determine Warnings

Crear y documentar un VI sencillo.

Debe crear una parte de un proyecto mayor. El desarrollador principal
le proporciona las entradas del VI, el algoritmo y las posibles salidas.
Cree y documente un VI en funcién del disefio dado.

Entradas y salidas

Tipo

Nombre

Propiedades

Control numérico

Current Temp

Doble precisién y
coma flotante

Control numérico Max Temp Doble precision y
coma flotante
Control numérico Min Temp Doble precisién y

coma flotante

Indicador de cadena
de caracteres

Warning Text

Tres valores en

potencia: advertencia

de golpe de calor,
sin advertencia y
advertencia de
congelacion

Indicador LED redondo

Warning?




Diagrama de flujo

Warning Text =
Heatstroke
Warning

Warning Text =
No Warning

Warning Text = Pass current value
Freeze Warning of Warning Text

Warning
Text = No
Warning?

Yes

Warning ? = False Warning ? = True

6

Figura 4-10. Diagrama de flujo del VI Determine Warnings



implementacion

¥

Siga las instrucciones inferiores para crear un panel frontal similar al

de la figura 4-11. El usuario introduce la temperatura actual, la mixima y
la minima. A continuacion, el panel frontal muestra la cadena de caracteres
de advertencia y el LED booleano de advertencia. Este VI forma parte del
proyecto de la estaciéon meteorolégica de temperatura estudiado durante

el curso.

1. Abra un VI nuevo y cree el siguiente panel frontal.

FMax Teymp,

_I'-*Ein Temp -

Fi
NP

S WWarning Text

warning?

9

Figura 4-11. Panel frontal del VI Determine Warnings

2. Guarde el nuevo VI.

[ Seleccione File»Save.

O Guarde el VI como Determine Warnings.vi en el directorio
<Exercises>\LabVIEW Basics I\Determine Warnings.

3. Cree un control numérico para la temperatura actual.

O Cambie la etiqueta del control numérico a Current Temp.

U Haga clic con el botén derecho en el control, seleccione
Representation y confirme que el tipo de representacion esta
configurado en doble precisién.

Consejo Este subVI podria utilizarse para Fahrenheit, Kelvin u otra escala de
temperatura, siempre que todas las entradas utilicen la misma escala. Por lo tanto,

U Afiada un control numérico a la ventana del panel frontal.

no es necesario afiadir unidades de escala a las etiquetas.




4. Cree un control numérico para la temperatura maxima.

0 Mantenga pulsada la tecla <Ctrl> y haga clic y arrastre el control
numérico Current Temp para crear una copia del control.

U Cambie el texto de la etiqueta del nuevo control numérico a
Max Temp.

5. Cree un control numérico para la temperatura minima.

U Mantenga pulsada la tecla <Ctrl> y haga clic y arrastre el control
numérico Max Temp para crear una copia del control.

O Cambie el texto de la etiqueta del nuevo control numérico a
Min Temp.

6. Cree un indicador de cadena de caracteres para el texto de advertencia.

abe U Afiada un indicador de cadena de caracteres a la ventana del panel
' frontal.

U Cambie el texto de la etiqueta del indicador de cadena de caracteres
aWarning Text.

7. Cree un LED redondo u otro indicador booleano para el booleano
de advertencia.

O Afiada un LED redondo a la ventana del panel frontal.
L Cambie el texto de la etiqueta del indicador booleano a warning?.

8. Cambie al diagrama de bloques.

Consejo Sino desea ver terminales como iconos en el diagrama de bloques, seleccione
Tools»Options y después Block Diagram de la lista Category. Elimine la marca del
elemento Place front panel terminals as icons.



Siga las instrucciones inferiores para crear un diagrama de blogues similar

al de la figura 4-12.

Current Termp

S N -"\"—\.‘
el

éFreeze Warning :

E

|

Warring Test

yibc]

stvns

IHeatstroke Warning

b

3
i3

[ i

."‘\,_. .

“Warning?

",_",,' 7
\_1‘

Figura 4-12. Diagrama de bloques del VI Determine Warnings

9. Compare Current Temp y Max Temp.

U Afilada una funcién Greater Or Equal? al diagrama de bloques.

U Cablee el control Current Temp a la entrada x de la funcién Greater

Or Equal?.

U Cablee el control Max Temp a la entrada y de la funcién Greater Or

Equal?.

10. Compare Current Temp y Min Temp.

U Afiada una funcién Less Or Equal? al diagrama de bloques.

U Cablee el control Current Temp a la entrada x de la funcién

Less Or Equal?.

U Cablee el control Min Temp a la entrada y de la funcion Less Or

Equal?.

11. Siel valor Current Temp es igual o mayor que Max Temp, genere una
cadena de caracteres Heatstroke Warning, de lo contrario genere

una cadena de caracteres No Warning.

O Aifiada la funcién Select al diagrama de bloques a la derecha de

la funcién Greater Or Equal?.

(0 Cablee la salida de la funcién Greater Or Equal? a la entrada s de

la funcidn Select.




12.

Q

Afiada una constante de cadena de caracteres al diagrama de bloques
a la parte superior izquierda de la funcién Select.

Escriba Heatstroke Warning en la constante de cadena de
caracteres.

Cablee la cadena de caracteres Heatstroke Warning alaentrada
t de la funcién Select.

Mantenga pulsada la tecla <Ctrl> y haga clic y arrastre la constante
de cadena de caracteres Heatstroke Warning a la parte inferior
izquierda de la funcién Select para crear una copia de la constante.

Escriba No Warning en la segunda constante de cadena de
caracteres.

Cablee la cadena de caracteres No Warning ala entrada f de
la funcién Select.

Si la Current Temp es igual o menor que la Min Temp, genere una
cadena de caracteres Freeze Warning, de lo contrario use la cadena
de caracteres generada en el paso 11.

a

Cree una copia de la funcién Select y coléquela a la derecha de
la funcién Less Or Equal?.

Cablee la salida de la funcién Less Or Equal? a la entrada s de
la funcién Select.

Cree una copia de la constante de cadena de caracteres y coldquela
en la parte superior derecha de la funcidn Select.

Escriba Freeze Warning en la constante de cadena de caracteres.

Cablee la cadena de caracteres Freeze Warning a la entrada t de
la funcion Select.

Cablee la salida de la funcidn Select anterior a la entrada f de
la nueva funcidn Select.



13. Muestre el texto generado.

14.

15.

Q

Cablee la salida de la segunda funcion Select con el indicador
Warning Text.

Genere el control booleano Warning? determinando si el valor de
Warning Text es igual a No Warning.

a

Q

Afiada una funcién Not Equal? a la izquierda del control booleano
Warning?.

Cablee la salida de la segunda funcién Select a la entrada x de
la funcién Not Equal?.

Cablee la constante de cadena de caracteres No Warning a
la entrada y de la funcién Not Equal?.

Cablee la salida de la funcién Not Equal? al control Warning?.

Documente el codigo utilizando estas sugerencias en el panel frontal.

Q

Q

Cree ayudas para cada control e indicador que describa la finalidad
y las unidades del objeto. Para acceder a las ayudas, haga clic con
el boton derecho en un objeto y seleccione Description and Tip.

Documente las propiedades del VI, ofreciendo una descripcién
general del VI, una lista de entradas y salidas, su nombre y la fecha
en que se cred el VI. Para acceder al cuadro de didlogo VI
Properties, seleccione File»VI Properties.

Documente el algoritmo del diagrama de bloques con una etiqueta
libre.

16. Guarde el VI.




Prueba

1.

Pruebe el V1introduciendo un valor para Current Temp, Max Temp y

Min Temp y ejecutando el VI para cada configuracion.

La tabla 4-1 muestra la cadena de caracteres esperada Warning Text y
el valor booleano Warning? para cada ajuste de valores de entrada.

Tabla 4-1. Probar valores para el VI Determine Warnings

Current Temp Max Temp Min Temp Warning Text Warning?

30 30 10 Heatstroke True
Warning

25 30 10 No Warning False

10 30 10 Freeze True
Warning

)

P

. Qué ocurre si introduce un valor Max Temp inferior a Min Temp?
. Qué cree que sucederia? Aprenderd a manejar problemas similares
en el ejercicio 4-6.

Guarde y cierre el VL.

Fin del ejercicio 4-1




D. Bucles While

Al igual que un bucle Do o un bucle Repeat-Until en lenguajes de
programacion basados en texto, un bucle While, mostrado en la figura 4-13,
ejecuta un subdiagrama hasta que ocurra una condicion.

La siguiente ilustracién muestra un bucle While en LabVIEW, un diagrama
de flujo equivalente a la funcionalidad del bucle While, y un ejemplo de
pseudocddigo de la funcionalidad del bucle While.

No Repeat (code);

Condition
met?

Until Condition met;

End;

Condition met?

[ i@]

@ ® ®

1 Bucle While de LabVIEW 2 Diagrama de flujo 3 Pseudocddigo

Figura 4-13. Bucle While

El bucle While se encuentra en la paleta Structures. Seleccione el bucle
While en la paleta y después use el cursor para arrastrar un rectangulo de
seleccidn alrededor de la seccidn del diagrama de bloques que desee repetir.
Cuando suelte el botén del ratén, un limite de bucle While encerraré la
seccion que selecciond.

Afiada objetos del diagrama de bloques al bucle While arrastrandolos y
soltandolos dentro de éste.

@ Consejo El bucle While siempre se ejecuta al menos una vez.

El bucle While ejecuta el subdiagrama hasta que el terminal condicional,
un terminal de entrada, reciba un valor booleano especifico. El terminal
condicional en un bucle While acttia del mismo modo que en un bucle For
con un terminal condicional. No obstante, como el bucle For también
incluye un contaje de iteraciones configurado, no se ejecuta hasta el infinito
si la condicién nunca ocurre. El bucle While no incluye un contaje de
iteraciones configurado y se ejecuta hasta el infinito si la condicién nunca
ocurre.



Si un terminal condicional es Stop if True, coloca el terminal de un control
booleano fuera de un bucle While, y si el control es FALSE cuando se inicia
el bucle, provocard un bucle infinito, como se muestra en el siguiente
ejemplo. También provoca un bucle infinito si el terminal condicional es
Continue if True y el control fuera del bucle se configura en TRUE.

Para convertir un bucle While en uno For, haga clic con el botén derecho en
el bucle While y seleccione Replace with For Loop en el menu contextual.
(Windows, ETS) Para convertir un bucle While en uno Timed, haga clic con
el botén derecho en el bucle While y seleccione Replace with Timed Loop
en el menu contextual.

Figura 4-14. Bucle infinito

Si cambia el valor del control, no detendrd el bucle infinito, porque el valor
sOlo se lee una vez, antes de que empiece el bucle. Para detener un bucle
infinito, debe abortar el VI haciendo clic en el botén Abort Execution en
la barra de herramientas.

También puede realizar un control de errores bésicos con el terminal
condicional de un bucle While. Cuando cablea un cluster de error al terminal
condicional, s6lo pasa al terminal el valor TRUE o FALSE del pardmetro
status del cluster de error. Asimismo, los elementos del ment contextual
Stop if True y Continue if True cambian a Stop if Error y Continue
while Error.

Consulte la seccidén Gestion de errores del capitulo 6, Ejecucion y
depuracion de VIs, para obtener informacién adicional acerca de clusters
de errores y control de errores.

El terminal de iteracion, que se ve abajo, es un terminal de salida que
contiene el numero de iteraciones completadas.

[



El contaje de iteraciones siempre empieza en cero. Durante la primera
iteracion, el terminal de iteracidn devuelve 0.

En el siguiente diagrama de bloques, el bucle While se ejecuta hasta que
la salida de la funcién Random Number sea mayor o igual que 10,00y

el control Enable sea True. La funcién And devuelve True sélo si ambas
entradas son True. De lo contrario, devolverd False.

En el siguiente ejemplo, existe mayor posibilidad de un bucle infinito.

o
Generalmente, el comportamiento deseado es que se cumpla una condicién
para detener el bucle, en lugar de necesitar que se cumplan ambas
condiciones.

Enable
‘E}}

Iterations

[

Figura 4-15. Posible bucle infinito

Tineles de estructuras

Los tineles suministran datos hacia dentro y hacia fuera de las estructuras.
El tanel aparece como un bloque sélido en el borde del bucle While.

El bloque es del color del tipo de datos cableado al tinel. Los datos salen de
un bucle cuando éste termina. Cuando un ttinel introduce datos en un bucle,
éste se ejecuta s6lo cuando los datos llegan al tinel.

En el siguiente diagrama de bloques, el terminal de iteracion se conecta a un
tunel. El valor del tinel no entra en el indicador Iterations hasta que el bucle
While termine de ejecutarse.

Iterations

Figura 4-16. Tdnel del bucle While



Sélo aparece en el indicador Iterations el tltimo valor del terminal de
iteracion.

Uso de bucles While para gestion de errores

Puede cablear un cluster de error al terminal condicional de un bucle While
o un bucle For con un terminal condicional para detener la iteracion del
bucle. Cuando cablea un cluster de error al terminal condicional, sélo pasa
al terminal el valor TRUE o FALSE del pardametro status del cluster de
error. Si ocurre un error, el bucle se detendra. En un bucle For con un
terminal condicional, también debe cablear un valor al terminal de contaje
o autoindexar un array de entrada para configurar un nimero maximo de
iteraciones. El bucle For se ejecuta hasta que ocurra un error o hasta que se
complete el numero de iteraciones configurado.

Si cablea un cluster de error al terminal condicional, los elementos del menu
contextual Stop if True y Continue if True cambiardn a Stop on Error y
Continue while Error.

En la figura 4-17, el cluster de error y un boton de parada se utilizan para
determinar cudndo detener el bucle. Este es el método recomendado para
detener la mayoria de los bucles.

=

a
Tty
!

Simulate Signal

wrror ol Femrenes n skatys | .

stop

Figura 4-17. Detener un bucle While



Ejercicio 4-2 Vi Auio Maich

Objetivo
Usar un bucle While y un terminal de iteracion y pasar datos por un tiinel.
Caso
Cree un VI que genere continuamente nimeros aleatorios entre 0y 1.000
hasta que genere un niimero que coincida con el que seleccione el usuario.
Determine cudntos niimeros aleatorios generd el VI antes de que el nimero
coincidiera.
Diseiio
Tabla 4-2. Entradas y salidas
Tipo Nombre Propiedades
Entrada Number to Match Doble precisién, coma flotante
entre O y 1000, convertir al
ndmero natural mas cercano,
valor predeterminado = 50
Salida Current Number Doble precision y coma
flotante
Salida Number of Nimero entero
Iterations




Diagrama de flujo

Generate a
Random Number |« No —
Between 0 and 1

Multiply by 1000
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’ Terminal
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Display Number
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Figura 4-18. Diagrama de flujo de Auto Match




Implementacion

Abra un VI nuevo y cree el siguiente panel frontal. Modifique los controles
e indicadores como se muestra en el siguiente panel frontal y como se

describe en estos pasos.

‘Number to Match
550

Current Number

# of iterations:

o

Figura 4-19. Panel frontal del VI Auto Match

1. Abra un VI nuevo.

2. Guarde el VI como Auto Match.vi en el directorio <Exercises>\
LabVIEW Basics I\Auto Match.

3. Cree la entrada Number to Match.

U Afiada un control numérico a la ventana del panel frontal.

U Etiquete el control Number to Match.

4. Configure el valor predeterminado para el control Number to Match.

U Configure el control Number to Match en 50.

O Haga clic con el botén derecho en el control Number to Match y
seleccione Data Operations»Make Current Value Default.

5. Configure las propiedades del control Number to Match para que
el intervalo de datos sea de 0 a 1000, el valor de incremento sea 1 y
los digitos de precision sean O.

Q

Haga clic con el botén derecho en el control Number to Match y
seleccione Data Entry en el ment contextual. Aparecerd la pdgina
Data Entry del cuadro de didlogo Numeric Properties.

Desmarque la casilla de verificacién Use Default Limits.

Configure el valor Minimum a 0 y seleccione Coerce en el ment

desplegable Response to value outside limits.




U Configure el valor Maximum a 1000 y seleccione Coerce en
el menu desplegable Response to value outside limits.

U Configure el valor Increment a 1 y seleccione Coerce en el menu
desplegable Response to value outside limits.

Seleccione la ficha Display Format.

Seleccione Floating Point y cambie el tipo de precision de
Significant digits a Digits of precision.

U Escriba 0 en el cuadro de texto Digits y haga clic en OK.
Cree la salida Current Number.

U Afada un indicador numérico a la ventana del panel frontal.
U Etiquete el indicador Current Number.

(L Haga clic con el botén derecho en el indicador y seleccione
Advanced»Synchronous Display.

Configure a 0 los digitos de precision para la salida Number to Match.

(0 Haga clic con el botén derecho en el indicador Current Number y
seleccione Display format en el menu contextual. Aparecerd la
pdgina Display Format del cuadro de didlogo Numeric Properties.

(1 Seleccione Floating Point y cambie el Precision Type a Digits of
precision.

(1 Escriba 0 en el cuadro de texto Digits y haga clic en OK.
Cree la salida # of iterations.

U Coloque un indicador numérico en el panel frontal.

U Etiquete el indicador # of iterations.

Configure la representacién para la salida # of iterations en un nimero
entero largo.

U Haga clic con el botén derecho en el indicador # of iterations.

U Seleccione Representation»I32 en el ment contextual.



Cree el siguiente diagrama de bloques. Siga estos pasos.

Round To Nearest
L P S
e i

. Mok Equal?

;[g_}

)

Inctement & of iterations

nteration starts at 0
so increment by 1

Figura 4-20. Diagrama de bloques del VI Auto Match

10. Genere un ntimero integral aleatorio entre 0 y 1.000.

U Afiada la funcién Random Number (0-1) al diagrama de bloques.
La funcién Random Number (0-1) produce un nimero aleatorio

entreelOyel .

(L} Afiada la funcién Multiply al diagrama de bloques. La funcién
Multiply multiplica el ndmero aleatorio por la entrada y para
producir un nimero aleatorio entre el O e y.

U Cablee la salida de la funcién Random Number a la entrada x de

la funcién Multiply.

U Haga clic con el botén derecho en la entrada y de la funcién
Multiply, seleccione Create»Constant en el meni contextual,
escriba 1000 y pulse la tecla <Intro> para crear una constante

numeérica.

(0  Afiada la funcién Round To Nearest al diagrama de bloques. Esta
funcién redondea el niimero aleatorio al nimero entero mas cercano.

O Cablee la salida de la funcién Multiply a la entrada de la funcién
Round To Nearest. Cablee la salida de la funcién Round To Nearest

al indicador Current Number.

11. Compare el nimero generado aleatoriamente con el valor del control

Number to Match.

0 Afada la funcién Not Equal? al diagrama de bloques. Esta funcién
compara el nimero aleatorio con Number to Match y devuelve True
si los nimeros no son iguales; de lo contrario, devuelve False.

1 Cablee la salida de la funcién Round To Nearest a la entrada x de

la funcién Not Equal?.




U Cablee el control numérico Number to Match con el borde del bucle
While. Aparecerd un tinel naranja en el borde del bucle While.

0 Cablee el tiinel naranja a la entrada y de la funcién Not Equal?.
12. Repita el algoritmo hasta que la funcién Not Equal? devuelva True.

O Aifiada un bucle While desde la paleta Structures al diagrama de
bloques.

(1 Haga clic con el botén derecho en el terminal condicional y
seleccione Continue if True en el menu contextual.

U Cablee la salida de la funcién Not Equal? al terminal condicional.

13. Muestre al usuario la cantidad de niimeros aleatorios generados
afiadiendo uno al valor del terminal de iteracion.

m (1 Cablee el terminal de iteracién al borde del bucle While. Aparecerd
un tanel azul en el borde del bucle While.

@ Consejo Cada vez que se ejecute el bucle, el terminal de iteracién aumentard en uno.
Cablee el valor de iteracién a la funcién Increment porque el contaje de iteraciones
empieza en 0. El contaje de iteraciones sale del bucle al completarse.

. U Afiada la funcién Increment al diagrama de bloques. Esta funcién
-~ suma | al contaje del bucle While.

14. Guarde e] VI.

Prueba
1. Abra el panel frontal.

[N

Cambie el nimero en Number to Match a un numero que se encuentre
en el rango de datos, que es de 0 a 1.000 con un incremento de 1.

3. Ejecuteel VI.

4. Cambie Number to Match y ejecute el VI de nuevo. Current Number
se actualiza en cada iteracién del bucle porque se encuentra dentro de €l.
# of iterations se actualiza al completarse porque se encuentra fuera del
bucle.



5. Para ver como el VI actualiza los indicadores, habilite el resaltado
de ejecucion.

Q En el diagrama de bloques, haga clic en el boton Highlight
Execution para habilitar el resaltado de ejecucién. El resaltado de
la ejecucidn muestra el movimiento de datos en el diagrama de
bloques desde un nodo a otro para que pueda ver cada ndmero segiin
lo genera el VI.

6. Ejecute el VI y observe el flujo de datos.

7. Intente hacer coincidir un nimero que se encuentre fuera del rango
de datos.

8. Cambie Number to Match a un nimero que se encuentre fuera del
rango de datos. [

U Ejecute el VI. LabVIEW convierte el valor fuera de rango al valor
mds cercano en el rango de datos especificado.

9. Cierre el VL

Fin del ejercicio 4-2




E. Bucles For

Un bucle For, mostrado abajo, ejecuta un subdiagrama cierto nimero
de veces.

La figura 4-21 muestra un bucle For en LabVIEW, un diagrama de flujo
equivalente a la funcionalidad del bucle For, y un ejemplo de pseudocédigo
de la funcionalidad del bucle For.

100N
N=100;
Code i=0;
Until i=N:
X i N e Repeat {code; i=i+l);
m End;
J
1 Bucle For de LabVIEW 2 Diagrama de flujo 3 Pseudocodigo

Figura 4-21. Bucle For

El bucle For se encuentra en la paleta Structures. También puede colocar

un bucle While en el diagrama de bloques; haga clic con el botén derecho

en el borde del bucle While y seleccione Replace with For Loop en el menti
contextual para cambiar un bucle While por uno For. El terminal de contaje,
que se ve abajo, es un terminal de entrada cuyo valor indica cudntas veces

debe repetir el subdiagrama.

El terminal de iteracion, que se ve abajo, es un terminal de salida que
contiene el numero de iteraciones completadas.

[

El contaje de iteraciones siempre empieza en cero. Durante la primera
iteracion, el terminal de iteracion devuelve 0. Si el contaje de iteraciones
supera 2.147.483.647 o 231, el terminal de iteracién permanecera en
2.147.483.647 para todas las iteraciones siguientes. Si necesita contar mas
de 2.147.483.647 iteraciones, puede utilizar registros de desplazamiento
con un rango de nimero entero mayor.



El bucle For se diferencia del bucle While en que aquél se ejecuta un nimero
determinado de veces. Un bucle While deja de ejecutar el subdiagrama sélo
si existe el valor en el terminal condicional.

El siguiente bucle For genera un ntimero aleatorio cada segundo durante
100 segundos y muestra los niimeros aleatorios en un indicador numérico.

N
Randam Number (0-1)

Rardorn Murnber

o 7

Figura 4-22. Ejemplo de bucle For

Aiadir un terminal condicional a un hucle For

Si es necesario, puede afiadir un terminal condicional para configurar un
bucle For para que se detenga cuando ocurra un error o una condicién
booleana. Un bucle For con un terminal condicional se ejecuta hasta que
ocurra la condicidn o hasta que se completen todas las iteraciones, lo que
suceda primero. Los bucles For que configure para una salida condicional
tendrdn un simbolo rojo en el terminal de contaje y un terminal condicional
en la esquina inferior derecha. Tras configurar el bucle For para salir
condicionalmente, el bucle aparece similar a la figura 4-23. El siguiente
bucle For genera un niimero aleatorio cada segundo hasta que transcurran
100 segundos o hasta que el usuario haga clic en el botén de parada.

Ws
Random Mumber {0-1)

Random Mumber
Indicator

e
i g stap
¥

[

Figura 4-23. Bucle For configurado para una salida condicional

Para afiadir un terminal condicional a un bucle For, haga clic con el botén
derecho del borde del bucle For y seleccione Conditional Terminal en

el mend contextual. A continuacién, cablee el terminal condicional y

el terminal de contaje.



100 N
Random Mumber (0-13

Random Mumber Visible Ttermns N
Indicator

Help

Description and Tip...

- LE
1000 f- b Set Breakpoint
[i] Structures Palstte 14

4  Auko Grow

Conditional Terrrinal
Replace with Wwhile Loop
Remove For Loop

Add Shift Register

Figura 4-24. Anadir un terminal condicional a un bucle For

Conversion numérica

LabVIEW puede representar tipos de datos numéricos como nimeros
enteros con signo o sin signo, valores numéricos de coma flotante o valores
numéricos complejos, como se describi6 en la seccidn Tipos de datos de
LabVIEW de esta leccion. Normalmente, cuando cablea tipos distintos de
representaciones en las entradas de una funcion, ésta devuelve una salidaen
el formato mds grande o amplio. Si usa un nimero entero con signo con un
nimero entero sin signo, lo convertird al nimero entero sin signo. Si usa un
ndmero entero sin signo con uno en coma flotante, lo convertird a coma
flotante. Si usa un nimero entero en coma flotante con un nimero complejo,
lo convertird al niimero complejo. Si usa dos nimeros del mismo tipo con
distinto ancho de bits, LabVIEW realizard la conversion al mayor de los dos
anchos de bits. Si el nimero de bits es el mismo, LabVIEW elige niimeros
enteros sin signo en vez de con signo. Por ejemplo, si cablea un DBL y un
132 a una funcién Multiply, el resultado es un DBL, como se muestra en

la figura 4-25. LabVIEW realizard la conversion al nimero entero con signo
de 32 bits porque utiliza menos bits que el valor numérico de doble precision
y de coma flotante. La entrada inferior de la funcién Multiply muestra un
punto rojo, llamado punto de conversion, que indica que LabVIEW estd
realizando una conversion de datos.

DEL Murmeric

132 Murneric
52k

1 Punto de conversion

Figura 4-25. Ejemplo de conversion numérica



Sin embargo, el terminal de contaje del bucle For funciona del modo
opuesto. Si cablea un valor numérico de doble precision y en coma flotante
al terminal de contaje de 32 bits, LabVIEW convierte el valor numérico
mayor a un ntimero entero con signo de 32 bits. Aunque la conversion es
contraria a los estdandares normales de conversién, es necesaria, ya que un
bucle For s6lo puede ejecutarse un niimero entero de veces.

Cionble-Precision
F!n ing Poink

G2-Bik Sioned Inkeasr

[l [

1 Punto de conversion

Figura 4-26. Conversion en un bucle For




Ejercicio 4-3 Concepto: bucles While frente a hucles For

Objetivo

Descripcion

Comprender cudndo se usa un bucle While y cudando uno For.

En los siguientes escenarios, decida si usar un bucle While o For.

Escenario 1

Adquiere datos de presion cada segundo durante un minuto.

1. Siusaun bucle While, ;qué condicion necesita para detener el bucle?

2. Siusaun bucle For, ;jcudntas iteraciones necesita ejecutar el bucle?

3. ¢Resulta mds facil implementar un bucle For o un bucle While?

Escenario 2

Adquiere datos de presion hasta que ésta es mayor o igual que 1.400 psi.

1. Siusaun bucle While, ;qué condicién necesita para detener el bucle?

2. Siusaun bucle For, ;cudntas iteraciones necesita ejecutar el bucle?

3. ¢(Resulta mds facil implementar un bucle For o un bucle While?



Escenario 3
Adquiere datos de presion y temperatura hasta que ambos valores son
estables durante dos minutos.

1. Siusa un bucle While, ;qué condicién necesita para detener el bucle?

2. Siusa un bucle For, ;cudntas iteraciones necesita ejecutar el bucle?

3. ¢Resulta més facil implementar un bucle For o un bucle While?

Escenario 4

Genera una rampa de tensién que comienza en cero, aumentando
incrementalmente en 0,5 V cada segundo, hasta que la tension de salida
esigualalSV.

1. Siusa un bucle While, ;qué condicidn necesita para detener el bucle?

2. Siusaun bucle For, jcudntas iteraciones necesita ejecutar el bucle?

3. (Resulta mas ficil implementar un bucle For o un bucle While?




Respuestas

Escenario 1
Adquiere datos de presién cada segundo durante un minuto.

1.

2

3.

Bucle While: Tiempo = 1 minuto
Bucle For: 60 iteraciones

Ambos son posibles.

Escenario 2
Adquiere datos de presion hasta que ésta sea 1.400 psi.

1.

2

o

3.

Bucle While: Presion = 1400 psi
Bucle For: no se sabe

Un bucle While. Aunque puede afladir un terminal condicional a un
bucle For, debe cablear un valor al terminal de contaje. Sin mds
informacién, no conoce el valor apropiado para cablear al terminal
de contaje.

Escenario 3

Adquiere datos de presion y temperatura hasta que ambos valores son
estables durante dos minutos.

1.

Bucle While: [(Ultima Temperatura = Temperatura Previa) durante
2 minutos o mds] y [(Ultima presion = Presion Previa) durante
2 minutos o mas]

2. Bucle For: no se sabe

3. Un bucle While. Aunque puede afiadir un terminal condicional a un
bucle For, debe cablear un valor al terminal de contaje. Sin més
informacién, no conoce el valor apropiado para cablear al terminal
de contaje.

Escenario 4

Genera una rampa de tension que comienza en cero, aumentando
incrementalmente en 0,5 V cada segundo, hasta que la tension de salida
esiguala5 V.

1.
2.
3.

Bucle While: Voltaje =5V
Bucle For: 11 iteraciones

Ambos son posibles.

Fin del ejercicio 4-3



F. Temporiza

cion de Vis

Cuando un bucle termina de ejecutar una iteracion, inmediatamente
empieza a ejecutar la siguiente, a menos que llegue a una condicion de
parada. Normalmente tendrd que controlar la frecuencia o temporizacion de
la iteracidn. Por ejemplo, si estd adquiriendo datos y desea hacerlo cada
10 segundos, necesita poder temporizar las iteraciones del bucle para que
ocurran cada 10 segundos.

Aungue no necesite que la ejecucion ocurra con cierta frecuencia, debe
facilitar al procesador tiempo para completar otras tareas, como responder a
la interfaz del usuario. Esta seccion explica métodos para temporizar los
bucles.

Funciones de espera

Coloque una funcidn de espera dentro de un bucle para que un VI se
desactive durante cierto tiempo. Esto permite al procesador abordar otras
tareas durante el tiempo de espera. Las funciones de espera usan el reloj de
milisegundos del sistema operativo.

La funcién Wait Until Next ms Multiple controla un contador de
milisegundos y espera hasta que éste alcance un multiplo de la cantidad que
especifique. Use esta funcidn para sincronizar actividades. Sitte esta
funcién en un bucle para controlar la velocidad de ejecucion de éste. Para
que esta funcién sea efectiva, el tiempo de ejecucién del cddigo debe ser
inferior al tiempo especificado para esta funcion. El tiempo de ejecucion de
la primera iteracion del bucle es indeterminado.

La funcién Wait (ms) espera hasta que el contador de milisegundos cuente
una cantidad igual a la entrada que especifique. Esta funcién garantiza que
la velocidad de ejecucién del bucle se corresponda al menos con el valor que
especifique a la entrada de la funcidn.

@ Nota EI VI Express Time Delay acttia de modo similar a la funcién Wait (ms) pero
con clusters de error integrados. Consulte la leccion 3, Resolucion de problemas y
depuracion de Vs, para obtener informacién adicional acerca de los clusters de error.

Tiempo transcurrido

&

En algunos casos, resulta ttil determinar cudnto tiempo transcurre después
de un punto en su VI. El VI Express Elapsed Time indica el tiempo
transcurrido tras el instante de inicio especificado. Este VI Express controla
el tiempo mientras que el VI sigue ejecutdndose. Este VI Express no facilita
al procesador el tiempo para completar otras tareas. Utilizard el VI Express
Elapsed Time en el proyecto del curso Weather Station.




G. Transferencia de datos iterativa

Al programar con bucles, a menudo debe acceder a datos de iteraciones
anteriores del bucle en LabVIEW. Por ejemplo, si estd adquiriendo un dato
en cada iteracién de un bucle y debe hallar el promedio cada cinco datos,
debe conservar los datos de iteraciones anteriores del bucle. Los registros de
desplazamiento transfieren valores de una iteracién del bucle a la siguiente.

@ Nota Los nodos de realimentacién son otro método para conservar informacion de una
iteracion anterior. Consulte el tema Feedback Node de la Ayuda de LabVIEW para
obtener informacién adicional acerca de nodos de realimentacion.

Los registros de desplazamiento son similares a las variables estdticas en
lenguajes de programacién basados en texto.

Use registros de desplazamiento cuando desee pasar valores de iteraciones
anteriores a la siguiente iteracion a través del bucle. Un registro de
desplazamiento aparece como un par de terminales, mostrados abajo,
directamente opuestos entre si en los lados verticales del borde del bucle.

= &

El terminal de la derecha del bucle contiene una flecha hacia arriba y
almacena datos al completar una iteraciéon. LabVIEW transfiere los datos
conectados al lado derecho del registro en la siguiente iteracion. Después de
que se ejecute el bucle, el terminal del lado derecho del bucle devuelve

el ultimo valor almacenado en el registro de desplazamiento.

Cree un registro de desplazamiento haciendo clic con el botén derecho en el
borde izquierdo o derecho de un bucle y seleccionando Add Shift Register
en el menu contextual.

Un registro de desplazamiento transfiere cualquier tipo de datos y cambia
automaticamente al tipo de datos del primer objeto cableado al registro de
desplazamiento. Los datos que cablee a los terminales de cada registro de
desplazamiento deben ser del mismo tipo.

Puede afiadir mds de un registro de desplazamiento a un bucle. Si tiene
varias operaciones que usan valores de iteraciones previas dentro del bucle,
use varios registros de desplazamiento para almacenar los valores de datos
de los distintos procesos en la estructura, como se muestra en la siguiente
figura.



Figura 4-27. Uso de varios registros de desplazamiento

Inicializacion de registros de desplazamiento

Al inicializar un registro de desplazamiento, se restablece el valor que
transmite el registro de desplazamiento a la primera iteracion del bucle
cuando se ejecuta un VI. Inicialice un registro de desplazamiento cableando
un control o constante al terminal del registro de desplazamiento en el lado
izquierdo del bucle, como se muestra en el siguiente diagrama de bloques.

;ncrement l
[ e b

Furmeric
132

En el diagrama de bloques anterior, el bucle For se ejecuta cinco veces,
incrementando el valor que lleva el registro de desplazamiento en uno cada
vez. Tras cinco iteraciones del bucle For, el registro de desplazamiento pasa
el valor final, 5, al indicador y el VI finaliza su ejecucién. Cada vez que
ejecute el VI, el registro de desplazamiento empieza con un valor de 0.

Sino inicializa el registro de desplazamiento, el bucle usa el valor escrito en
el registro de desplazamiento cuando se ejecutd por Gltima vez el bucle o,
si éste nunca se ejecutd, usa el valor predeterminado del tipo de dato.

Use un registro de desplazamiento sin inicializar para conservar la
informacidn de estado entre las siguientes ejecuciones de un VI. El siguiente
diagrama de bloques muestra un registro de desplazamiento sin inicializar.




Increment Furneric

+

En el diagrama de bloques anterior, el bucle For se ejecuta cinco veces,
incrementando el valor que lleva el registro de desplazamiento en uno cada
vez. La primera vez que ejecute el VI, el registro de desplazamiento empieza
con un valor de 0, que es el valor predeterminado de un nimero entero de
32 bits. Tras cinco iteraciones del bucle For, el registro de desplazamiento
pasa el valor final, 5, al indicador y el VI finaliza su ejecucion. La siguiente
vez que ejecute el VI, el registro de desplazamiento comenzara con un valor
de 5, que era el dltimo valor de la ejecucion anterior. Tras cinco iteraciones
del bucle For, el registro de desplazamiento pasa el valor final, 10, al
indicador. Si ejecuta de nuevo el VI, el registro de desplazamiento empieza
con un valor de 10,y asi sucesivamente. Los registros de desplazamiento sin
inicializar conservan el valor de la iteracion anterior hasta que cierre el VI.

Registros de desplazamiento apilados

Los registros de desplazamiento apilados permiten acceder a datos de
iteraciones anteriores al bucle. Los registros de desplazamiento apilados
almacenan valores de varias iteraciones anteriores y llevan esos valores a
las siguientes iteraciones. Para crear un registro de desplazamiento apilado,
haga clic con el botén derecho en el terminal izquierdo y seleccione

Add Element en el menu contextual.

Los registros de desplazamiento apilados sélo pueden utilizarse en el
lado izquierdo del bucle, porque el terminal derecho transfiere los datos
generados s6lo desde la iteracién actual a la siguiente, como se muestra
en este diagrama de bloques.

Flumeric
132




Si afiade otro elemento al terminal izquierdo del diagrama de bloques

anterior, los valores de las dos dltimas iteraciones se transmiten a la

siguiente iteracion, almacendndose el valor de iteracién mas reciente en el ,;
registro de desplazamiento superior. El terminal inferior almacena los datos

que le llegan de la iteracion anterior.




Ejercicio 4-4 VI Average Temperature

Objetivo

Escenario

Diseiio

Usar un bucle While y registros de desplazamiento para hallar el promedio
de datos.

El VI Temperature Monitor adquiere y muestra la temperatura. Modifique
el VI para hallar el promedio de las tres dltimas mediciones de temperatura
y mostrar el promedio mévil en el grifico tipo “waveform chart”.

La figura 4-28 y la figura 4-29 muestran el panel frontal y el diagrama de
bloques del VI Temperature Monitor.

Ternperature History
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Figura 4-28. Panel frontal del VI Temperature Monitor
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Figura 4-29. Diagrama de bloques del VI Temperature Monitor

Para modificar este VI, debe conservar los valores de temperatura de las dos
iteraciones anteriores y hallar el promedio de los valores. Use un registro de
desplazamiento con un elemento adicional para conservar los datos de

las dos iteraciones anteriores. Inicialice el registro de desplazamiento con
una lectura desde el sensor de temperatura. Registre graficamente sélo

la temperatura media.



impiemeniacion

1. Pruebe el VI. Si dispone del hardware, siga las instrucciones de
la columna Con hardware instalado. De lo contrario, siga
las instrucciones de la columna Sin hardware instalado.

Con hardware instalado

Sin hardware instalado

Abra el VI Temperature Monitor en
el directorio <Exercises>\LabVIEW
Basics I\Average Temperature.

Abra el VI Temperature Monitor (Demo)
en el directorio <Exercises>\LabVIEW
Basics I\No Hardware Required\
Average Temperature.

Seleccione File»Save As y renombre el VI
coOmo Average Temperature.vien
el directorio <Exercises>\LabVIEW
Basics I\Average Temperature.

Seleccione File»Save As y renombre el VI
como Average Temperature.vien

el directorio <Exercises>\LabVIEW
Basics I\No Hardware Required\
Average Temperature.

En el Accesorio de sefiales DAQ, cambie el
interruptor de ruido del sensor de temperatura
a la posicién On. Este interruptor introduce
ruido en la lectura de la temperatura.

Ejecute el VI.

Coloque el dedo en el sensor de temperatura
del Accesorio de sefiales DAQ, para aumentar
la lectura de la temperatura. Puede mover
rdpidamente el dedo por el sensor para
aumentar la lectura ain més con la friccién.
Observe el elevado nimero de picos en

la lectura.

Ejecute el VI. Observe la variacién en
la lectura de la temperatura simulada.

2. Detenga el VI cambiando el estado del interruptor Power en el panel
frontal. Observe que el interruptor Power cambia inmediatamente al
estado On. La accidén mecdnica del interruptor controla este

comportamiento.

En los siguientes pasos, modifique el VI para reducir el nimero de picos

de temperatura.

3. Abra el diagrama de bloques.

4. Modifique el diagrama de bloques como en la figura 4-30.
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Figura 4-30. Diagrama de bloques del VI Average Temperature

Haga clic con el botdn derecho en el borde derecho o izquierdo del
bucle While y seleccione Add Shift Register en el menu contextual
para crear un registro de desplazamiento.

Haga clic con el botén derecho en el terminal izquierdo del registro
de desplazamiento y seleccione Add Element en el menti contextual
para afiadir un elemento al registro de desplazamiento.

Pulse la tecla <Ctrl> mientras hace clic en el VI Thermometer y
arrastrelo fuera del bucle While para crear una copia del subVI.

El VI Thermometer devuelve una medida de temperatura desde el
sensor de temperatura e inicializa los registros de desplazamiento
izquierdos antes de que se inicie el bucle.

Coloque la funcién Compound Arithmetic en el diagrama de
bloques.

— Configure esta funcién para devolver la suma de la temperatura
actual y las dos lecturas anteriores de la temperatura.

— Use la herramienta de posicionamiento para cambiar el tamafio
de la funcién Compound Arithmetic para tener tres terminales a
la izquierda.

Coloque la funcién Divide en el diagrama de bloques. Esta funcién
devuelve el promedio de las tres tiltimas lecturas de temperatura.

Cablee las funciones como en la figura 4-30.

Haga clic con el botén derecho en la entrada y de la funcién Divide
y seleccione Create»Constant.

Introduzca 3 y pulse la tecla <Intro>.

Guarde el VL.




Prueba
I. Ejecute el VI.

2. Sitiene el hardware instalado, coloque el dedo en el sensor de
temperatura del Accesorio de Sefiales DAQ, para aumentar la lectura
de la temperatura.

Durante cada iteracién en el bucle While, el VI Thermometer toma
una medida de temperatura. El VI afiade este valor a las dos dltimas
mediciones almacenadas en los terminales izquierdos del registro de
desplazamiento. El VI divide el resultado entre tres para averiguar

la media de las tres mediciones (la medida actual mas las dos
anteriores). El VI muestra el promedio en el grifico tipo “waveform
chart”. Observe que el VI inicializa el registro de desplazamiento con
una medida de temperatura.

3. Detenga el VI cambiando el estado del interruptor Power en el panel
frontal.

4. Cierre el VI.

Fin del ejercicio 4-4



H. Representacion de datos

Ya utilizé graficos y tablas para representar datos sencillos. Esta seccion
explica mds en profundidad cémo usar y personalizar tablas y graficos.

Graficos tipo “waveform chart”

El grifico tipo “waveform chart” es un tipo especial de indicador numérico
que muestra una o mds curvas de datos, normalmente adquiridos a una
velocidad constante. Los graficos tipo “waveform chart” pueden mostrar
una o varias curvas. La figura 4-31 muestra los elementos de un grafico tipo
“waveform chart” de varias curvas. Aparecen dos curvas: Raw Data (datos
en bruto) y Running Avg (promedio modvil).

Raw Data
@——b W aveform Chart Runring Avg.

v

Amplitude

1 Etiqueta 3 EscalaX 5 Paleta del grafico
2 EscalaY 4 Leyenda de la escala 6 Leyenda de la curva

Figura 4-31. Graficos tipo “waveform chart”

Puede configurar cémo se actualiza el grafico para mostrar nuevos datos.
Haga clic con el botén derecho en el grafico y seleccione Advanced»
Update Mode desde el menu contextual para configurar el modo de
actualizacion del grafico. El grafico utiliza los siguientes modos para
mostrar datos:

» Strip Chart: muestra los datos méviles desplazandose continuamente
de izquierda a derecha por el grédfico con los datos antiguos a la
izquierda y con los nuevos a la derecha. Un strip chart es similar a un
registrador de cinta de papel. Strip Chart es el modo de actualizacién
predeterminado.



* Scope Chart: muestra un elemento de datos, como un impulso o una
onda, desplazdndose parcialmente por el grifico de izquierda a derecha.
Para cada nuevo valor, el grifico traza el valor a la derecha del tltimo
valor. Cuando la curva llega al borde derecho de la zona de trazado,
LabVIEW borra la curva y empieza a trazar de nuevo desde el borde
izquierdo. La visualizacién de un scope chart es similar a la de un
osciloscopio.

»  Sweep Chart: funciona de modo parecido a un scope chart salvo que
muestra los datos antiguos a la derecha y los nuevos a la izquierda
separados por una linea vertical. LabVIEW no borra la curva en un
sweep chart cuando ésta llega al borde derecho de la zona de trazado.
Un sweep chart es similar a la visualizacién de un electrocardiograma.

La figura 4-32 muestra un ejemplo de cada modo de actualizacién del
grafico. El scope chart y el sweep chart tienen visualizaciones de retrazado
parecidas a un osciloscopio. Como retrazar una curva requiere menos
esfuerzo, el scope chart y el sweep chart muestran curvas mucho mas
rdpidamente que el strip chart.

Stiip Chart

80.0-

Scope Chatt Sweep Chatt
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Figura 4-32. Modos de actualizacion de graficos

Cableado de graficos

Puede cablear una salida escalar directamente a un gréfico tipo “waveform
chart”. El terminal del gréfico tipo “waveform chart” de la figura 4-33
coincide con el tipo de datos de entrada.

HTemp

Figura 4-33. Cableado de una sola curva a un grafico tipo “waveform chart”




Los grificos tipo “waveform chart” pueden mostrar varias curvas juntas
usando la funcién Bundle situada en la paleta Cluster, Class & Variant.
En la figura 4-34, la funcién Bundle une las salidas de los tres VIs en

la curva del gréfico tipo “waveform chart”.

ﬂTemp
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Figura 4-34. Cableado de varias curvas a un grafico tipo “waveform chart”

El terminal del gréfico tipo “waveform chart” cambia para coincidir con

la salida de la funcién Bundle. Para afiadir mas curvas, use la herramienta
de posicionamiento para cambiar el tamaio de la funcién Bundle. Consulte
laleccién 5, Relacionar datos, para obtener informacién adicional acerca de
la funcién Bundle.

Graficos tipo “Waveform graph”

Los Vs con un grifico normalmente acumulan los datos en un array y
después los trazan en el grafico. La figura 4-35 muestra los elementos
de un gréfico tipo “waveform graph”.

@'—P Waveform Graph
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3 Marca de cuadricula 7 Leyenda del cursor 11 Etiqueta
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Figura 4-35. Grafico tipo “Waveform Graph”



Los graficos situados en la paleta Graph Indicators incluyen los tipos
“waveform graph”y “XY graph”. El tipo “waveform graph” sélo representa
funciones de una tnica variable, como en y = f(x), con puntos distribuidos
uniformemente en el eje x, como las formas de onda adquiridas variables
con el tiempo.

Los graficos XY muestran cualquier conjunto de puntos, muestreados
uniformemente o no.

Cambie el tamaifio de la leyenda de la curva para ver varias curvas. Use
varias curvas para ahorrar espacio en el panel frontal y comparar curvas.
Los gréficos tipo “XY” y “waveform” se adaptan automaticamente a varias
curvas.

Graficos tipo “Waveform graph” de una sola curva

El grafico tipo “waveform graph” acepta varios tipos de datos para graficos
de una sola curva. El gréfico tipo “graph” acepta un solo array de valores,
interpreta los datos como puntos del grafico e incrementa el indice x en uno
empezando por x = 0. Asimismo acepta un cluster con un valor inicial x, un
valor deltax y un array de datos y. Por Giltimo, también acepta el tipo de datos
de forma de onda, que contiene los datos, tiempo de inicio y el valor delta ¢
de una forma de onda.

Consulte el VI Waveform Graph de labview\examples\general\
graphs\gengraph. 11b para ver ejemplos de los tipos de datos que
acepta un gréfico tipo “waveform graph”.

Graficos tipo “Waveform graph” de varias curvas

El gréafico tipo “waveform graph” acepta varios tipos de datos para mostrar
varias curvas. Acepta un array 2D de valores, donde cada fila de ésta es
una sola curva. El grifico interpreta los datos como puntos del mismo e
incrementa el indice x en uno, empezando por x = 0. Cablee un tipo de datos
de array 2D al gréfico tipo “graph”, haga clic en éste con el botén derecho
y seleccione Transpose Array en el ment contextual para tratar cada
columna del array como una curva. Esto resulta especialmente ttil cuando
muestrea varios canales de un dispositivo DAQ, porque éste puede devolver
los datos como arrays 2D con cada canal almacenado como una columna
distinta.

Consulte el grafico (Y) Multi Plot 1 en el VI Waveform Graph de
labview\examples\general\graphs\gengraph.llb para ver un
ejemplo de un grifico que acepta este tipo de datos.

El grafico tipo “waveform graph” también acepta un cluster con un valor
inicial x, un valor delta x y un array 2D de datos y. El grafico interpreta los
datos y como puntos del mismo e incrementa el indice x por el valor delta x,




empezando por el valor x inicial. Este tipo de datos resulta titil para mostrar
varias sefiales que se muestrean a la misma velocidad regular. Consulte

el grafico (Xo = 10, dX =2, Y) Multi Plot 2 en el VI Waveform Graph de
labview\examples\general\graphs\gengraph.1llb para ver un
ejemplo de un grifico que acepta este tipo de datos.

El grifico tipo “waveform graph” acepta un array de curvas donde el array
contiene clusters. Cada cluster contiene un array 1D que alberga los datos y.
El array interno describe los puntos de una curvay el externo tiene un cluster
para cada curva. El siguiente panel frontal muestra este array de clusters y.

Use un array de curva en lugar de un array 2D si el niimero de elementos de
cada curvaes distinto. Por ejemplo, cuando muestrea datos de varios canales
con distintos tiempos para cada uno, use esta estructura de datos en lugar de
un array 2D porque cada fila de un array 2D debe tener el mismo ndmero
de elementos. El nimero de elementos de los arrays interiores de un array
de clusters puede variar. Consulte el grafico (Y) Multi Plot 2 en el VI
Waveform Graph de labview\examples\general\graphs\
gengraph.1l1lb para ver un ejemplo de un grafico que acepta este tipo

de datos.

El grafico tipo “waveform graph” acepta un cluster de un valor inicial x, un
valor delta x y un array que contiene clusters. Cada cluster contiene un array
1D que alberga los datos y. Use la funcién Bundle para unir los arrays en
clusters y use la funcién Build Array para crear los clusters resultantes en un
array. También puede utilizar la funcién Build Cluster Array, que crea arrays
de clusters que contienen las entradas que especifique. Consulte el grifico
(Xo=10,dX =2,Y) Multi Plot 3 en el VI Waveform Graph de labview\
examples\general\graphs\gengraph.11b para ver un ejemplo de
un gréafico que acepta este tipo de datos.

El grafico tipo “waveform graph” acepta un array de clusters de un valor x,
un valor delta x y un array de datos y. Este es el més general de los tipos de
datos de graficos tipo “waveform graph” de varias curvas, porque puede
indicar un unico punto de inicio e incrementar la escala x de cada curva.
Consulte el grafico (Xo = 10, dX =2, Y) Multi Plot 1 en el VI Waveform
Graphde labview\examples\general\graphs\gengraph.1l1lb para
ver un ejemplo de un grafico que acepta este tipo de datos.



El grifico tipo “waveform graph” también acepta el tipo de datos dindmicos,
que se usa con los VIs Express. Ademas de los datos asociados con una
sefial, el tipo de datos dindmicos incluye atributos con informacién sobre
la sefial, como el nombre de la sefial o la fecha y la hora en que se
adquirieron los datos. Los atributos especifican como aparece la sefial en el
grafico. Cuando el tipo de datos dindmico incluye varios canales, el grafico
muestra una curva para cada canal y da formato automaticamente a

la leyenda de la curva y la marca de hora de la escala x.

Graficos XY de una sola curva

El grifico XY acepta tres tipos de datos para graficos XY de una sola curva.
El gréfico XY acepta un cluster que contiene un array x y un array y.
Consulte el grafico (X and Y arrays) Single Plot en el VI XY Graph de
labview\examples\general\graphs\gengraph.llb para ver un
ejemplo de un grafico que acepta este tipo de datos.

El grifico XY también acepta un array de puntos, donde un punto es un

cluster que contiene un valor x y un valor y. Consulte el grafico (Array of [
Pts) Single Plot en el VI XY Graph de labview\examples\general)\
graphs\gengraph. 11b para ver un ejemplo de un grafico que acepta este
tipo de datos. El grdfico XY también acepta un array de datos complejos,
donde la parte real se traza en el eje x y la parte imaginaria en el eje y.

Graficos XY de varias curvas

El grafico XY acepta tres tipos de datos para mostrar varias curvas. Acepta

un array de curvas, donde una curva es un cluster que contiene un array x y

un array y. Consulte el grafico (X and Y arrays) Multi Plot en el VI XY
Graphde 1labview\examples\general\graphs\gengraph.llbpara i
ver un ejemplo de un gréifico que acepta este tipo de datos.

El grafico XY también acepta un array de clusters de curvas, siendo una '
curva un array de puntos. Un punto es un cluster que contiene un valor x y
un valor y. Consulte el grafico (Array of Pts) Multi Plot en el VI XY Graph
de labview\examples\general\graphs\gengraph.1llb para verun
ejemplo de un grifico que acepta este tipo de datos. El grafico XY también
acepta un array clusters de curvas, siendo una curva un array de datos
complejos, donde la parte real se traza en el eje x y la parte imaginaria
enelejey.




Ejercicio 4-5 VI Temperature Multipiot

Objetivo

Escenario

Diseiio

Representar varios conjuntos de datos en un solo grafico tipo “waveform
chart” y personalizar su vista.

Modifique el VI del ejercicio 4-4 para representar la temperatura actual y
el promedio mévil en el mismo grafico. Ademds, el usuario debe poder
examinar una parte de la curva mientras los datos se estdn adquiriendo.

La figura 4-36 muestra el panel frontal del VI (VI Average Temperature)
existente y la figura 4-37 muestra el diagrama de bloques.

Temperature History

i
10.0
Time (sec)

Figura 4-36. Panel frontal del VI Average Temperature

Para que el usuario pueda examinar una parte de la curva mientras los datos
se estdn adquiriendo, muestre la leyenda escalas y la paleta del grafico tipo
“waveform chart”. Asimismo, expanda la leyenda para mostrar curvas
adicionales.

Para modificar el diagrama de bloques de la figura 4-37, debe modificar
el terminal del gréfico para aceptar varios datos. Use una funcién Bundle
para combinar la temperatura media y la actual en un cluster y cablearlo al
terminal del grdfico Temperature History.
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Figura 4-37. Diagrama de bloques del VI Average Temperature

Implementacion

1. Abrael VI creado en el ejercicio 4-4. Si dispone del hardware, siga las
instrucciones de la columna Con hardware instalado. De lo contrario,
siga las instrucciones de la columna Sin hardware instalado.

Con hardware instalado

Sin hardware instalado

Abra el VI Average Temperature en
el directorio <Exercises>\LabVIEW
Basics I\Average Temperature.

Abra el VI Average Temperature en

el directorio <Exercises>\LabVIEW
Basics I\No Hardware Required\
Average Temperature

Seleccione File»Save As y llame al VI
Temperature Multiplot.vi en

el directorio <Exercises>\LabVIEW
Basics I\Temperature Multiplot.

Seleccione File»Save As y llame al VI
Temperature Multiplot.vien

el directorio <Exercises>\LabVIEW
Basics I\No Hardware Required\
Temperature Multiplot.

¥

Consejo  Seleccione la opcion Substitute Copy for Original para cerrar el VI Average

Temperature y trabajar en el VI Temperature Multiplot. Puede crear el directorio si no

existe.




En las instrucciones inferiores, modificard el diagrama de bloques similar
para incluir la funcionalidad mostrada en la figura 4-38. Modifique primero
el diagrama de bloques y luego el panel frontal.
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Figura 4-38. Diagrama de bloques del VI Temperature Multiplot

2. Abra el diagrama de bloques.

3. Conecte las temperaturas actual y la media al terminal de grifico
Temperature History.

Q

Elimine el cable que conecta la funcion Divide al terminal del
grifico Temperature History.

Afiada una funcién Bundle entre la funcién Divide y el indicador del
grifico Temperature History. Si es necesario, amplie el bucle
While para hacer espacio.

Cablee la salida de la funcién Divide a la entrada superior de
la funcién Bundle.

Cablee la temperatura actual a la entrada inferior de la funcién
Bundle. La temperatura actual es la salida del subVI Thermometer
dentro del bucle While.

Cablee la salida de la funcién Bundle del indicador del grifico
Temperature History.




En los siguientes pasos modifique el panel frontal para obtener una
apariencia similar al de la figura 4-39.
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Figura 4-39. Panel frontal del VI Temperature Multiplot
4. Abra el panel frontal.

5. Muestre ambas curvas en la leyenda de curvas del gréfico tipo
“waveform chart”.

O Use la herramienta de posicionamiento para cambiar el tamafio de
la leyenda de curvas para mostrar dos objetos, mediante el nodo \
de cambio de tamafio de la parte media superior.

Llame a la curva superior Running Avg.
Llame a la curva inferior Current Temp. A
Cambie el tipo de curva de Current Temp. Use la herramienta de

posicionamiento para seleccionar la curva en la leyenda de curvas y {
elija la representacidn que desee. '

Consejo El orden de las curvas que aparecen en la leyenda de curvas es el mismo que
el de los elementos cableados a la funcién Bundle del diagrama de bloques.




Prueba

6. Muestre la leyenda de escalas y la paleta de gréfico del grafico tipo
“waveform chart”.

O Haga clic con el botén derecho en el grifico Temperature History
y seleccione Visible Items»Scale Legend en el menu contextual.

@ Haga clic con el botén derecho en el grafico Temperature History
y seleccione Visible Items»Graph Palette en el ment contextual.

7. Guarde el V1.

1. Ejecute el VI. Use las herramientas de la leyenda de escalas y la paleta
de grifico para examinar los datos que genere.

1

Cambie el interruptor Power a la posicién Off para detener el VI.

3. Cierre el VI tras terminar.

Fin del ejercicio 4-5



I. Estructuras Case

Una estructura Case, como la de abajo, tiene dos o0 mas subdiagramas o
casos.

M Trus M2

Sélo se ve un subdiagrama a la vez y la estructura ejecuta sélo un caso cada
vez. Un valor de entrada determina qué subdiagrama ejecutar. La estructura
Case es similar a las declaraciones switch o a las declaraciones
if...then...else en lenguajes de programacién basados en texto.

La etiqueta del selector de caso en la parte superior de la estructura Case,
mostrada abajo, contiene en el centro el nombre del valor de seleccién que
se corresponde con el caso actual y las flechas de incremento y decremento
a cada lado.

M True ~b]

Haga clic en las flechas de incremento y decremento para desplazarse por
los casos disponibles. También puede hacer clic en la flecha junto al nombre
del caso y seleccionar un caso del menu desplegable.

Cablee un valor de entrada, o selector, al terminal de seleccidn, mostrado
abajo, para determinar qué caso se ejecuta.

Debe cablear un niimero entero, un valor booleano, una cadena de caracteres
o un valor de tipo enumerado en el terminal de seleccién. Puede colocar el
terminal de seleccion en cualquier parte del borde izquierdo de la estructura
Case. Si el tipo de dato del terminal de seleccidn es booleano, la estructura
tiene un caso TRUE y uno FALSE. Si el terminal de seleccion es un nimero
entero, cadena de caracteres o valor de tipo enumerado, la estructura puede
tener cualquier nimero de casos.

Sino especifica un caso predeterminado para que la estructura Case controle
valores fuera de rango, debe enumerar explicitamente cada valor de entrada
posible. Por ejemplo, si el selector es un niimero entero y especifica casos
para 1, 2 y 3, debe especificar un caso predeterminado a ejecutar si el valor
de entrada es 4 u otro valor de ntimero entero sin especificar.

@ Nota No puede especificar un caso predeterminado si cablea un control booleano al
selector. Si hace clic con el botdn derecho en la etiqueta del selector de caso, Make This
The Default Case no aparecerd en el menu contextual. Seleccione el valor TRUE o
FALSE en el control booleano para determinar qué caso ejecutar.




Para convertir una estructura Case en una estructura Stacked Sequence,
haga clic con el botén derecho en la estructura Case Sequence y seleccione
Replace with Stacked Sequence en el menu contextual.

Haga clic con el botén derecho en el borde de la estructura Case para afiadir,
duplicar, eliminar o reordenar casos y para seleccionar un caso
predeterminado.

Seleccionar un caso

La figura 4-40 muestra un VI que utiliza una estructura Case para ejecutar
codigo diferente en funcidn de si un usuario selecciona °C o °F como
unidades de temperatura. El diagrama de bloques superior muestra el caso
True en primer plano. En el diagrama de bloques intermedio, se selecciona
el caso False. Para seleccionar un caso, escriba el valor en el identificador
del selector de caso o use la herramienta de etiquetado para modificar los
valores. Tras seleccionar otro caso, ése aparecerd en el diagrama de bloques,
como se muestra en el diagrama de bloques inferior de la figura 4-40.
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Figura 4-40. Cambiar la visualizacion de caso de una estructura Case

Si introduce un valor selector que no es del mismo tipo que el objeto
cableado al terminal de seleccion, el valor aparece en rojo. Esto indica que
el VI no se ejecutard hasta que elimine o modifique el valor. Asimismo,
debido al posible error de redondeo inherente de la aritmética de coma
flotante, no puede utilizar niimeros en coma flotante como valores de



seleccidn de caso. Si cablea un valor en coma flotante al caso, LabVIEW
redondeara el valor al nlimero entero par mds cercano. Si escribe un valor en
coma flotante en la etiqueta del selector de caso, el valor aparecera rojo para
indicar que debe eliminar o modificar el valor antes de que pueda ejecutarse
la estructura.

Tuneles de entrada y salida

Puede crear varios tineles de entrada y salida para una estructura Case.
Las entradas estan disponibles en todos los casos, pero los casos no
necesitan utilizar cada entrada. No obstante, debe definir un tinel de salida
para cada caso.

Piense en este ejemplo: una estructura Case en el diagrama de bloques tiene
un tinel de salida, pero en al menos uno de los casos no hay valor de salida
cableado al tanel. Si ejecuta este caso, LabVIEW no sabréd qué valor
devolver para la salida. LabVIEW indica este error dejando el centro del
tinel en blanco. El caso sin cablear podria no ser el caso que se estd viendo
en el diagrama de bloques.

Para corregir este error, muestre los casos que contienen el tinel de salida
sin cablear y cablee una salida al tinel. También puede hacer clic con el
botén derecho en el tinel de salida y seleccionar Use Default If Unwired
en el ment contextual para utilizar el valor predeterminado para el tipo de
datos del tinel en todos los tineles sin cablear. Cuando se cablea la salida
en todos los casos, el ttinel de salida aparece relleno con el color del tipo de
dato asociado al mismo.

Evite usar la opcién Use Default If Unwired. Si usa esta opcion, no
documentard bien el diagrama de bloques y podra confundir a otros
programadores que utilizan su c6digo. La opcién Use Default If Unwired
también dificulta la depuracién del cédigo. Si usa esta opcidn, tenga en
cuenta que el valor predeterminado utilizado es el del tipo de datos que estd
conectado al tiinel. Por ejemplo, si el tinel es un tipo de datos booleano,
el valor predeterminado es FALSE. Consulte la tabla 4-3 para ver una lista
de valores predeterminados para los tipos de datos.

Tabla 4-3. Valores predeterminados de tipos de datos

Tipo de datos Valor predeterminado

Numérico 0

Booleano FALSE

Cadena de caracteres vacio (7))




Ejemplos

En los siguientes ejemplos, los valores numéricos pasan por ttineles a
la estructura Case y se suman o restan, en funcién del valor cableado al
terminal de seleccion.

Estructura Case hooleana

La figura 4-41 muestra una estructura Case booleana. Los casos se solapan
entre sf para simplificar la ilustracion.
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Figura 4-41. Estructura Case booleana

Si el control booleano cableado al terminal de seleccién es True, el VI suma
los valores numeéricos. De lo contrario, el VI resta los valores numéricos.

Estructura Case de nimero entero

La figura 4-42 muestra una estructura Case de nimero entero.
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Figura 4-42. Estructura Case de nimero entero

Numeric es un control de anillo de texto situado en la paleta Text Controls
que asocia valores numéricos con elementos de texto. Si el niimero entero
cableado al terminal de seleccién es 0 (add), el VI suma los valores

numéricos. Si el valor es 1 (subtract), el VI resta los valores numéricos.




Si Numeric es cualquier otro valor distinto de 0 (add) o 1 (subtract),
el VI suma los valores numéricos, porque ése es el caso predeterminado.

Estructura Case de cadena de caracteres
La figura 4-43 muestra una estructura Case de cadena de caracteres.

Input X

Figura 4-43. Estructura Case de cadena de caracteres

SiString es add, el VI suma los valores numéricos. Si String es subtract,
el VI resta los valores numéricos.

Estructura Case enumerada

La figura 4-44 muestra una estructura Case enumerada.

Figura 4-44. Estructura Case enumerada

Un control de tipo enumerado facilita a los usuarios una lista de elementos
para seleccionar. El tipo de datos de un control de tipo enumerado incluye
informacion sobre los valores numéricos y etiquetas de cadenas de
caracteres del control. El selector de caso muestra la etiqueta de la cadena
de caracteres para cada elemento del control de tipo enumerado cuando
selecciona Add Case For Every Value en el ment contextual de la
estructura Case. La estructura Case ejecuta el subdiagrama de caso



apropiado en funcién del elemento actual del control de tipo enumerado.
En el diagrama de bloques anterior, si Enum es add, el VI suma los valores
numéricos. Si Enum es subtract, el VI resta los valores numéricos.

Uso de estructuras Case para gestionar errores

El siguiente ejemplo muestra una estructura Case donde un cluster de error
define los casos.
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Figura 4-45. Caso No Error
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Figura 4-46. Caso Error

Cuando cablea un cluster de error al terminal de seleccidn de una estructura
Case, la etiqueta del selector de caso muestra dos casos: Exrror y No
Error,y el borde de la estructura Case cambia de color: rojo para Exror y

verde para No Error. Siocurre un error, la estructura Case ejecuta el
subdiagrama Error.

Cuando cablea un cluster de error al terminal de seleccidn, la estructura
Case solo reconoce el elemento booleano status del cluster.



Ejercicio 4-6 Vi Determine Warnings

Objetivo

Escenario

Diseiio

Modificar un VI para utilizar una estructura Case y tomar una decision
software.

Ha creado un VI en el que el usuario introduce una temperatura, una
temperatura maxima y una minima. Se genera una cadena de caracteres

de advertencia en funcion de la relacion de las entradas. No obstante, una
situacién podria hacer que el VI funcionara incorrectamente. El usuario
podria introducir una temperatura maxima inferior a la temperatura minima.
Modifique el VI para generar otra cadena de caracteres que alerte al usuario
del: “Upper Limit < Lower Limit.” Configure el indicador Warning?
en True para indicar el error.

Modifique el diagrama de flujo creado para el VI Determine Warnings
original como en la figura 4-47.

Min. Temp 2
Max Temp

Create Error

\ 4

Output
Upper Limit
< Lower Limit
and TRUE

Output
Current Temp Current Temp No Warning
2 Max Temp £ Min. Temp and

FALSE

Output Output
Heatstroke Freeze Warning
Warning and and
TRUE TRUE

v
@

Figura 4-47. Diagrama de flujo de Determine Warnings modificado

El diagrama de bloques original del VI Determine Warnings aparece en

la figura 4-48. Este VI debe tener una estructura Case ailadida para ejecutar
el codigo si la temperatura maxima es mayor o igual que la temperatura
minima. De lo contrario, el c6digo no se ejecutara. En cambio, se genera una
nueva cadena de caracteres y el indicador Warning? se establece a True.
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Figura 4-48. Diagrama de blogues del VI Determine Warnings

Implementacion

Siga las instrucciones inferiores para crear un diagrama de bloques similar
al de la figura 4-49. Este VI forma parte del proyecto de la estacion
meteorolégica de temperatura.

- o 4|r$\‘
Min Temp
- WWarning?
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Figura 4-49. Diagrama de bloques del VI Determine Warnings

1. Abra el VI Determine Warnings en el directorio <Exercises>\
LabVIEW Basics I\Determine Warnings.

2. Abra el diagrama de bloques.



3. Cree espacio en el diagrama de blogues para afadir la estructura Case.

Los controles Max Temp y Min Temp y los indicadores Warning Text
y Warning? deben estar fuera de la nueva estructura Case, porque
ambos casos de la estructura Case utilizan estos indicadores y controles.

Q Seleccione los terminales de control Min Temp y Max Temp.

Consejo Para seleccionar mds de un elemento, pulse la tecla <Shift> mientras selecciona
los elementos.

L Mientras los terminales siguen seleccionados, use la tecla de flecha
izquierda del teclado para mover los controles a la izquierda.

Consejo Mantenga pulsada la tecla <Mayus> para mover los objetos en incrementos
de cinco pixeles.

U Seleccione los terminales indicadores Warning Text y Warning?.
U Alinee los terminales seleccionando Align Objects»Left Edges.

0 Mientras los terminales siguen seleccionados, use la tecla de flecha
derecha del teclado para mover los indicadores a la derecha.

mpare Min Temp y Max Temp.

Afiada la funcién Greater? al diagrama de bloques.

Co

d

O Cablee la salida Min Temp a la entrada x de la funcién Greater?.
O Cablee la salida Max Temp a la entrada y de la funcion Greater?.
Q

Afiada una estructura Case alrededor del c6digo del diagrama de
bloques, salvo para los terminales excluidos.

(1 Cablee la salida de la funcién Greater? al terminal de seleccidon
de caso de la estructura Case.

5. Si Min Temp es inferior a Max Temp, ejecute el cédigo que determina
el indicador y la cadena de caracteres de advertencia.

U Mientras permanece visible el caso True, haga clic con el botén
derecho en la estructura Case y seleccione Make This Case False
en el menu contextual. Cuando cree una estructura Case alrededor
del cédigo existente, éste se colocard automdticamente en el caso
True.




6. Si Min Temp es mayor que Max Temp, cree una cadena de caracteres
personalizada para el indicador Warning Text y configure el indicador
Warning? en True, como muestra la figura 4-50.

4 True 't

nguiger Limit < Lower Limit f-f ===~}

S
Warning?
2TE]
J

Figura 4-50. Diagrama de blogues del VI Determine Warnings

Seleccione el caso True.

(]

Haga clic con el botén derecho en el tinel de salida de cadena
de caracteres.

Seleccione Create»Constant.
Escriba Upper Limit < Lower Limit en la constante.
Haga clic con el botén derecho en el tunel de salida Warning?.

Seleccione Create»Constant.

I O O A A

Use la herramienta de operaciones para cambiar la constante a una
constante True.

7. Guarde el VI




Prueba
1. Cambie al panel frontal del VI.

2. Cambie el tamafio del indicador Warning Text para que pueda contener
la nueva cadena de caracteres.

3. Pruebe el VI introduciendo valores de la tabla 4-4 para Current Temp,
Max Temp y Min Temp y ejecutando el VI para cada conjunto de
datos.

La tabla 4-4 muestra los valores esperados de Warning Text y Warning?
para cada conjunto de datos.

Tabla 4-4. Valores de prueba para Determine Warnings.vi

Current Temp | Max Temp | Min Temp Warning Text Warning?
30 30 10 Heatstroke Warning | True
25 30 10 No Warning False
10 30 10 Freeze Warning True
25 20 30 Upper Limit < Lower | True
Limit

4. Guarde y cierre el VL.

Fin del ejercicio 4-6



Ejercicio 4-7

Objetivo

Escenario

Disefio

Autoestudio: VI Square Root

Crear un VI que utilice una estructura Case para tomar una decisién
de software.

Crear un VI que calcule la raiz cuadrada de un niimero que introduzca el
usuario. Si el niimero es negativo, muestra el siguiente mensaje al usuario:
Error...Negative Number.

Entradas y salidas

Tabla 4-5. Entradas y salidas

Tipo Nombre Propiedades

Entrada Number Doble precision y coma
flotante; valor
predeterminado de 25

Salida Square Root Value Doble precisién y coma
flotante

Diagrama de flujo

No Display
Error
Dialog

Yes

Find Square
Root of
Number

Figura 4-51. Diagrama de flujo del VI Square Root



implementacion

1. Abraun VI nuevo y cree el panel frontal de la figura 4-52.

Square Raot Yalus
0,00

Figura 4-52. Panel frontal del VI Square Root
2. Aifada un control numérico a la ventana del panel frontal.
U Llame al control numérico Number.
3. Anada un indicador numérico a la ventana del panel frontal.
U Llame al indicador numérico Square Root Value.

Cree el diagrama de bloques de la figura 4-53.

Root Value

Greater Or
Equal To 07 message

U . % ror.,.
[.-/, ! Negative Mumber
i

i
i One Butkon Dialog

Figura 4-53. Diagrama de bloques del VI Square Root

4. Determine si Number es mayor o igual que cero, porque no puede
calcular la raiz cuadrada de un niimero negativo.

U Afiada la funcién Greater or Equal to 07 a la derecha del control
[5'*__, - Number. Esta funcién devuelve True si Number es mayor o igual
que 0.
U Cablee Number a la entrada de la funcién Greater or Equal to 0?.
5. Si Number es menor que 0, muestre un cuadro de didlogo que informe
al usuario del error.
SRS U Afiada la estructura Case al diagrama de bloques.
b8 | o .
B U Haga clic en el botén de disminuir 0 aumentar para seleccionar

el caso False.



1 Afiada una constante numeérica al caso False.

[

Haga clic con el bot6n derecho en la constante numérica y
seleccione Representation»DBL.

Escriba ~99999 en la constante numeérica.
Cablee la constante numérica al borde derecho de la estructura Case.

Cablee el nuevo tinel al indicador Square Root Value.

(U U R A

Afiada la funcién One Button Dialog al caso False. Esta funcién
muestra un cuadro de didlogo que contiene un mensaje que
especifique.

m U Haga clic con el botén derecho en la entrada del mensaje de
o la funcién One Button Dialog y seleccione Create»Constant en
el menu contextual.

(1 Escriba Error...Negative Number en la constante.
U Termine de cablear el caso False como en la figura 4-53.
6. Si Number es mayor o igual que 0, calcule la raiz cuadrada del nimero.
[ O Seleccione el caso True de la estructura Case.

O Coloque la funcién Square Root en el caso True. Esta funcién
devuelve la raiz cuadrada de Number.

U Cablee la funcién como en la figura 4-54.

E 4 True 't]
Square Rook Square Root Value
3 [
3 ) -l L
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Equal To 07

Murnber
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Figura 4-54. Caso True del VI Square Root

7. Guarde el VI como Square Root.vi en el directorio <Exercises>\
LabVIEW Basics I\Sguare Root.



Prueba

4.

Abra el panel frontal.
Escriba un nlimero positivo en el control Number.
Ejecute el VI.

Escriba un ndmero negativo en el control Number.

/N Precaucion No ejecute este VI continuamente. Bajo ciertas circunstancias, ejecutar
continuamente este VI puede provocar un bucle infinito.

5.

6.

Ejecute el VI.

Si Number es positivo, el VI ejecuta el caso True y devuelve la raiz
cuadrada de Number. Si Number es negativo, el VI ejecuta el caso
False, devuelve ~99999 y muestra un cuadro de didlogo con el mensaje
Error...Negative Number.

Cierre el VL.

Fin del ejercicio 4-7




Ejercicio 4-8  Autoestudio: VI Determine Warnings (Reto)

Objetivo

Escenario

Disefio

Modificar un VI existente para utilizar una estructura Case o el Formula
Node y tomar una decision software.

En el VI Determine Warnings del ejercicio 4-1, seleccion6 la funcién Select
para pasar una cadena de caracteres basada en una decision. Revise este
diagrama de bloques para usar una estructura Case o Formula Node

(o una combinacién de ambos) para completar el mismo objetivo.

Entradas y salidas

Tahla 4-6. Entradas y salidas del VI Determine Warnings

Tipo Nombre Propiedades

Control numérico Current Temp Doble precision y coma
flotante

Control numérico Max Temp Doble precisién y coma
flotante

Control numérico Min Temp Doble precisién y coma
flotante

Indicador de cadena Warning Text Tres posibles valores:

de caracteres Heatstroke Warning,
No Warning o
Freeze Warning

LED redondo Warning? .




Diagrama de flujo

La figura 4-55 muestra el diagrama de flujo que utiliz6 en el ejercicio 4-1
para crear el VI Determine Warnings.

Current Temp

>=Max Temp? No
Yes
Warning Text = i =
Heatstroke Wsron\n/r\xlg;?:t i
Warning :

Warning Text = Pass current value
Freeze Warning of Warning Text

Warning
Text = No
Warning?

Yes

Warning ? = False Warning ? = True

o

Figura 4-55. Diagrama de flujo del VI Determine Warnings




Implementacion

Como parte del reto, no se incluyen instrucciones de implementacién en este
ejercicio. Abrael Vlen el directorio <Exercises>\LabVIEW Basics I\
Determine Warnings Challenge.

Si necesita ayuda, abra los Vs de soluciones, que se encuentran en
el directorio <Solutions>\LabVIEW Basics I\Exercise 4-8.

Fin del ejercicio 4-8



Ejercicio 4-9

Objetivo

Escenario

Disefio

Autoestudio: VI Determine More Warnings

Manipular cadenas de caracteres con funciones String.

Tiene un VI que determina si ha ocurrido una advertencia de golpe de calor
o una advertencia de congelacion, en funcién de la entrada de temperatura.
Debe ampliar este VI para que también determine si ha ocurrido una
advertencia de fuerte viento en funcién de una lectura de la velocidad del
viento y un ajuste de velocidad maxima del viento. Las advertencias deben
mostrarse como una tnica cadena de caracteres. Por ejemplo, si ha ocurrido
una advertencia de golpe de calor y otra de fuerte viento, la cadena de
caracteres mostrard: Heatstroke and High Wind Warning (advertencia de
golpe de calor y de fuerte viento).

Entradas y salidas

Tabla 4-7. Entradas y salidas del VI Determine More Warnings

Tipo

Nombre Propiedades

Control numérico

Current Temp Doble precision y coma flotante

Control numérico

Max Temp Doble precision y coma flotante

Control numérico

Temperatura min. Doble precisién y coma flotante

Control numérico

Current Wind Speed Doble precision y coma flotante

Control numérico

Max Wind Speed Doble precision y coma flotante

Indicador de cadena
de caracteres

Warning Text Valores posibles: Heatstroke Warning,
Freeze Warning, Heatstroke and High
Wind Warning, Freeze and High Wind
Warning, High Wind Warning y

No Warning

Indicador booleano

Warning? Booleano




Diagrama de flujo

El diagrama de flujo de la figura 4-56 se usa para el VI Determine Warnings.
Este VI no toma datos del viento. Modifique este diagrama de flujo para
determinar también la advertencia de fuerte viento.

Yes
Warning Text = i
Warning Text =
Heatst{oke No Warning
Warning

Current Temp
<= Min Temp?

Yes
Warning Text = Pass current value
Freeze Warning of Warning Text

Warning
Text = No
Warning?

Yes

Warning ? = False Warning ? = True

o

Figura 4-56. Diagrama de flujo del VI Determine Warnings



El diagrama de flujo modificado de la figura 4-57 determina la advertencia
de fuerte viento ademads de las advertencias ya determinadas.

Min Temp
Max Temp

Yes

Current Temp

No

Current Temp
< Min. Temp?

Current Wind

2 Max Temp? 2 Max Wind?

Create Create Create Create Create Create
“Heatstroke” Empty “Freeze” Empty “High Wind" Empty
String String String String String String
/ I | I |
Output *
Upper Limit -
< Lower Limit Combine
and TRUE Strings y
Combine and Display
Warning Text;
Determine and
Display Warning?
®
Figura 4-57. Diagrama de flujo del VI Determine More Warnings
Arguitectura del VI

Existen muchos modos de escribir este VI. En este ejercicio utilizara
estructuras Case para determinar qué cadena de caracteres pasar y la funcién
Concatenate Strings para unir cadenas de caracteres.




Implementacion

Una parte de este VI ya se ha creado. El panel frontal del VI aparece en

la figura 4-58. Este panel frontal recupera los valores del usuario para la
temperatura actual, la maxima, la minima, la velocidad actual del viento y
la velocidad médxima del viento y muestra al usuario la cadena de caracteres
de advertencia y el LED de advertencia. El proyecto de la estacion
meteoroldgica de este curso no utiliza este V1.

Current Temp : Current Wind Speed
T s
hy : "
Ma Temp. . MaxWind Speed - Warning Text

.

w10
T .

: Min Temp: : : Warning?

@

Figura 4-58. Panel frontal de Determine More Warnings

1. Abrael VI Determine More Warnings.vi en el directorio
<Exercises>\LabVIEW Basics I\Determine More Warnings.

Cree el diagrama de bloques para que se asemeje al de la figura 4-59.
2. Abra el diagrama de bloques.

3. Use las figuras 4-59 a la 4-63 para ayudarle a crear el codigo del
diagrama de bloques.

4. Usard los siguientes objetos del diagrama de bloques en este ejercicio:
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Figura 4-60. Casos True para cuando no se generan las advertencias
de temperatura y de viento
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Figura 4-62. Casos False para cuando se generan las advertencias
de temperatura y de viento
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Figura 4-63. Caso False para cuando se genera una advertencia de viento

5. Guarde el VL

Prueba
1. Pruebe los siguientes valores para asegurarse de que el VI funciona
segun lo esperado.
Tabla 4-8. Valores de la prueba meteoroldgica
Nombre Prueba 1 Prueba 2 Prueba 3 Prueba 4 Prueba 5 Prueba 6

Current Temp | 20 30 10 30 10 20

Max Temp 25 25 25 25 25 25

Min Temp 15 15 15 15 15 15

Current Wind | 25 25 25 35 35 35

Speed

Max Wind 30 30 30 30 30 30

Speed

Warning Text | No Warning Heatstroke Freeze Heatstroke Freeze and High Wind

Warning Warning and High High Wind Warning

Wind Warning
Warning

Warning? False True True True True True

2. Cierre y guarde el VI tras terminar.

Fin del ejercicio 4-9



Autorrevision: cuestionario

1. (Qué elemento de los siguientes identifica el control o indicador en
el diagrama de bloques?

a.
b.
c.
d.

Titulo
Ubicacién
Etiqueta
Valor

2. (Cudl de las siguientes estructuras deben ejecutarse al menos una vez?

a.
b.

Bucle While

Bucle For

3. ;Qué elemento de los siguientes SOLO estd disponible en el diagrama
de bloques?

a.
b.
c.
d.

Control
Constante
Indicador

Panel de conectores

4. ;Qué accién mecanica hace que un control booleano en el estado False
cambie a True cuando hace clic en él y permanezca True hasta que lo
libere y LabVIEW haya leido el valor?

a.
b.
C.
d.

Switch until released
Switch when released
Latch until released

Latch when released






Autorrevision: respuestas al cuestionario

1. ;Qué elemento de los siguientes identifica el control o indicador
del diagrama de bloques?

a. Titulo

b. Ubicacion

c. Etiqueta

d. Valor

. Cudl de las siguientes estructuras deben ejecutarse al menos una vez?
a. Bucle While

b. Bucle For

3. (Qué elemento de los siguientes SOLO esta disponible en el diagrama
de bloques?

o

a. Control

b. Constante

c. Indicador

d. Panel de conectores

4. ;Qué accién mecdanica hace que un control booleano en el estado False
cambie a True cuando hace clic en él y permanezca True hasta que lo
libere y LabVIEW haya leido el valor?

a. Switch until released
b. Switch when released
Latch until released

d. Latch when released



